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JFormDesigner 5.1 Documentation

1 Introduction

JFormDesigner is a professional GUI designer for Java Swing user interfaces. Its outstanding support for
JGoodies FormLayout, GroupLayout (Free Design), TableLayout and GridBagLayout makes it easy to
create professional looking forms.

Why use JFormDesigner?

JFormDesigner makes Swing GUI design a real pleasure. It decreases the time you spend on hand
coding forms, giving you more time to focus on the real tasks. You'll find that JFormDesigner quickly
pays back its cost in improved GUI quality and increased developer productivity. Even
non-programmers can use it, which makes it also ideal for prototyping.

Editions

JFormDesigner is available in five editions: as stand-alone application and as IDE plug-ins for Eclipse,
NetBeans, Intelli]l IDEA and JBuilder. This documentation covers all editions.

If there are functional differences between the editions, then they are marked with: Stand-alone,
Eclipse plug-in, NetBeans plug-in, IntelliJ IDEA plug-in, JBuilder plug-in or IDE plug-ins.

Key features

Easy and intuitive to use, powerful and productive
IDE plug-ins and stand-alone application
GrouplLayout (Free Design) support
® JGoodies FormLayout and TablelLayout support
® Advanced GridBaglLayout support
Column and row headers
Localization support
Beans Binding (JSR 295) support
BeanInfo Annotations
® Java code generator or runtime library
Generation of nested classes



2 User Interface
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This is the main window of JFormDesigner stand-alone edition:
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The main window consists of the following areas:

# Main Menu: Located at the top of the window.

® Toolbar: Located below the main menu.

® Palette: Located at the left side of the window.

# Design View: Located at the center of the window.

# Structure View: Located at the upper right of the window.

® Properties View: Located at the lower right of the window.

# Bindings View: Located below the Design view. This view is not visible by default. Click the Show
Bindings View button (ﬁ) in the toolbar to make is visible.

® Error Log View: Located below the Design view. This view is not visible in the above screenshot.



2.1 Menus
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You can invoke most commands from the main menu (at the top of the main frame) and the various
context (right-click) menus.

Main Menu

The main menu is displayed at the top of the JFormDesigner main window of the stand-alone edition.

|Ei|e Edit View Form Window Help

File menu

]
=

=T

F§

New Project
Open Project
Reopen Project
Project Properties

Close Project

New Form
Open Form

Reopen Form
Close
Close All

Save

Save As

Save All

Import

Exit

Edit menu

T
%
o

L&)

Undo
Redo
Cut

Copy
Paste

Rename

Delete

Creates a new project.

Opens an existing project.

Displays a submenu of previously opened projects. Select a project to open it.
Displays the project properties.

Closes the active project.

Creates a new form.

Opens an existing form.

Displays a submenu of previously opened forms. Select a form to open it.
Closes the active form.

Closes all open forms.

Saves the active form and generates the Java source code for the form (if Java Code
Generation is enabled in the Preferences).

Saves the active form under another file name or location and generates the Java source
code for the form (if Java Code Generation is enabled in the Preferences).

Saves all open forms and generates the Java source code for the forms (if Java Code
Generation is enabled in the Preferences).

Imports NetBeans, Intelli]J IDEA or Abeille form files and creates new JFormDesigner
forms. Use File > Save to save the new form in the same folder as the original form file.
This also updates the .java file.

Exits JFormDesigner. Mac: this item is in the JFormDesigner application menu.

Reverses your most recent editing action.

Re-applies the editing action that has most recently been reversed by the Undo action.
Cuts the selected components to the clipboard.

Copies the selected components to the clipboard.

Pastes the components in the clipboard to the selected container of the active form.

Renames the selected component.

Deletes the selected components.



View menu
[=] Show Diagonals

Squint Test

Qé-'b Refresh Designer

Form menu

{3 Test Form

Localize

L™

New Locale

Delete Locale

e 0 &

Externalize Strings

Internalize Strings

L"I

Ji| Generate Java Code

Window menu
Activate Designer
‘E@ Activate Structure
EE Activate Properties
#% Activate Bindings

€] Activate Error Log

Next Form
Previous Form

Preferences

Help menu

{7) Help Contents
What's New

Tip of the Day
Register

License

Check for Updates
About
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Shows diagonals.

Simulates evaluating a graphic layout by squinting your eyes. This tests legibility and
whether the overall layout is a strong, clear layout. You can change the squint intensity
in the Preferences.

Refresh the Design view of the active form. Reloads all classes used by the form and
recreates the form preview shown in the Design view. You can use this command, if you
changed the code of a component used in the form to reload the component classes. But
usually this is not necessary because JFormDesigner automatically reloads component
classes.

Tests the active form. Creates live instances of the form in a new window. You can close
that window by pressing the Esc key when the window has the focus. If your form
contains more than one top-level component, use the drop-down menu in the toolbar to
test another component.

Edit localization settings, resource bundle strings, create new locales or delete locales.
Creates a new locale.

Deletes an existing locale.

Moves strings to a resource bundle for localization. Use this command to start localizing
existing forms.

Moves strings from a resource bundle into the form and remove the strings from the
resource bundle.

Generates the Java code for the active form. Usually it's not necessary to use this
command because when you save a form, the Java code will be also generated.

Activates the Design view.

Activates the Structure view.

Activates the Properties view.

Activates the Bindings view. By default, the Bindings view is not visible.

Activates the Error Log view. By default, the Error Log view is not visible. It
automatically appears if an error occurs.

Activates the next form.
Activates the previous form.

Opens the Preferences dialog. Mac: this item is in the JFormDesigner application menu.

Displays help topics.

Displays what's new in the current release.

Displays a list of interesting productivity features.

Activates your license.

Displays information about your license.

Checks whether a newer version of JFormDesigner is available.

Displays information about JFormDesigner and the system properties. Mac: this item is
in the JFormDesigner application menu.
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Context menus

Context menus appear when you're right-click on a particular component or control.

Design view context menu: Properties view context menu:
E——a—H] I] -
e . Il = -~ WL
“hone: i - Mame | value
: V align: v % +[hight Sl Properties (12, 7 s=)
ZIF / Cit l background
Country Set labelFor 4 d?splayed EZ  Restore Default Value
& Bind y displayed
enabled EL  SetValue to null
Add Event Handler r Fant
Marph Bean... foregrour ﬁ Bind...
] horizonta
Nest in JPanel icon B Edernalize String
labelFor . .
of  Cut Cirl+X text ®, Internalize String
toolTipT:
L vet:ﬁglnle ! ForceValue
FlExpert P % Mo Java Code
Il D asd_mank -
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2.2 Toolbars

Toolbars provides shortcuts to often used commands.

Main Toolbar

This is the toolbar of JFormDesigner stand-alone edition. Many of the commands are also used in the
toolbars of the IDE plug-ins.

HEe-wm e EHE| %ot E | % | @ - | Windows -

= ék- ™ German (de) 37&9’|E|@

1% New Project Creates a new project.
== Open Project Opens an existing project.
1.1 Project Properties Displays the project properties.
* New Form Creates a new form.
= Open Form Opens an existing form.
L;:;J Save Saves the active form and generates the Java source code for the form (if Java Code
Generation is enabled in the Preferences).
”J.m.l Save All Saves all open forms and generates the Java source code for the forms (if Java Code
Generation is enabled in the Preferences).
<',1’ Undo Reverses your most recent editing action.
i‘l’) Redo Re-applies the editing action that has most recently been reversed by the Undo action.
'-'f." Cut Cuts the selected components to the clipboard.
= Copy Copies the selected components to the clipboard.
Paste Pastes the components in the clipboard to the selected container of the active form.
¥ Delete Deletes the selected components.
{} Test Form Tests the active form. Creates live instances of the form in a new window. You can close

that window by pressing the Esc key when the window has the focus. If your form
contains more than one top-level component, use the drop-down menu to test another

component.
Windows = Allows you to change the look and feel of the components in the Design view. You can
add other look and feels in the Preferences.
[=] Show Diagonals Shows diagonals.
Squint Test Simulates evaluating a graphic layout by squinting your eyes. This tests legibility and

whether the overall layout is a strong, clear layout. You can change the squint intensity
in the Preferences.

Q,lg-'t- Refresh Designer Refresh the Design view of the active form. Reloads all classes used by the form and
recreates the form preview shown in the Design view. You can use this command, if you
changed the code of a component used in the form to reload the component classes. But
usually this is not necessary because JFormDesigner automatically reloads component
classes.

™8 German (de) Allows you to change the locale of the form in the Design view. "(no locale)" is show if
the form is not localized. Use Form > Externalize Strings to start localizing a form.

@ Localize Edit localization settings, resource bundle strings, create new locales or delete locales.

gﬁ Show Bindings View Shows the Bindings view.

m Generate Java Code  Generates the Java code for the active form. Usually it's not necessary to use this
command because when you save a form, the Java code will be also generated.

@ Help Contents Displays help topics.
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2.3 Design View

This view is the central part of JFormDesigner. It displays the opened forms and lets you edit forms.

I,;-I. sTutorial | [5 AddressPanel

= 1 ]| 3 Wl |+ & o |e T o
[ T ] T

1| Jaeneral

3 Company

5 Contact

7 i-"mpeller
9 PTT [kw] 2ower [kw]

11 R [mm] D [mm]

Stand-alone: At top of the view, tabs are displayed for each open form. Click on a tab to activate a
form. To close a form, click the & symbol that appears on the right side of a tab if the mouse is over it.
An asterisk (*) in front of the form name indicates that the form has been changed.

IDE plug-ins: The Design view is integrated into the IDEs, which have its own tabs.

On the top and left sides of the view, you can see the column and row headers. These are important
controls for grid-based layout managers. Use them to insert, delete or move columns/rows and change
column/row properties.

In the center is the design area. It displays the form, grids and handles. You can drag and drop
components, resize, rename, delete components or in-place-edit labels.

Selecting components

To select a single component, click on it. To select multiple components, hold down the Ctrl (Mac:
Command) or Shift key and click on the components. To select the parent of a selected component,
hold down the Alt key (Mac: Option key) and click on the selected component.

To select components in a rectangular area, select Marquee Selection in the Palette and click-and-drag
a rectangular selection area in the Design view. Or click-and-drag on the free area in the Design view. All
components that lie partially within the selection rectangle are selected.

Propeller

= S —a—n
ST ey g TEA

g £ 0w

The selection in the Design view and in the Structure view is synchronized both ways.

Drag feedback

JFormDesigner provides four types of drag feedback.

7IP { City: Name: 5 ihorth

Wesl East
I} “hone: +] L\}H_)
@ A
ity: - South
column 1, row 7 Al
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The gray figure shows the outline of the dragged components. It always follows the mouse location. The
green figure indicates the drop location, the yellow figure indicates a new column/row and red figures
indicate occupied areas.

Cursor feedback

JFormDesigner uses various cursors while dragging components:

% The dragged components will be moved to the new location.

s
s
s

Either add a new component to the form or copy existing components.
Add multiple components of the same type to the form.

It is not possible to drop the component at this location.

© @ © @

Add components

To add components, choose a component from the Palette and drop it to the location where you want to
add it.

To add multiple instances of a component, hold down the Ctrl key (Mac: Command key) while clicking
on the Design view.

Move or copy components

To move components simply drag them to the new location. You will get reasonable visual feedback
during the drag operation.

=" = i
A s
i - i

e = i (¥

To copy components, proceed just as moving components, but hold down the Ctrl key (Mac: Option
key) before dropping the components.

You can cancel all drag operations using the Esc key.

Resize components

Use the selection handles to resize components. Click on a handle and drag it.

Mame:

=

Thone:

7IP / City: [width 3, height1 (+2, 0}]

The green feedback figure indicates the new size of the component. The tool tip provides additional
information about location, size and differences.

Whether a component is resizable or not depends on the used layout manager.
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Morph components

The "Morph Bean" command allows you to change the class of existing components without loosing
properties, events or layout information. Right-click on a component in the Design or Structure view and
select Morph Bean from the popup menu.

Nest in Container

The "Nest in Container" command allows you to nest selected components in a new container (usually a
JPanel). Right-click on a component in the Design or Structure view and select Nest in JPanel from the
popup menu. The new container gets the same layout manager as the old container and is placed at the
same location where the selected components were located. For grid-based layout managers, the new
container gets columns and rows and the layout constraints of the selected components are preserved.

0 = Lxd

k3

1
0| Speed:mi T:)SL.:,.; F Modem 0| Bpeed: m(") DSL || () Modems

= = o

Non-visual beans

To add a non-visual bean to a form, select it in the Palette (or use Choose Bean) and drop it into the
free area of the Design view. Non-visual beans are shown in the Design view using proxy components.

@
addressObject

Red beans

If a bean could not instantiated (class not found, exception in constructor, etc), a red bean will be shown
in the designer view as placeholder.

com.myapp. MyFanel com. myapp. MylLabel

bext

To fix such problems, take a look at the Error Log view and if necessary add required jars to the
classpath of your project.

2.3.1 Headers

The column and row headers (for grid-based layout managers) show the structure of the layout. This
includes column/row indices, alignment, growing and grouping.

I3 1 L] 3

1| Mame:

2| 2hone:

Use them to insert, delete or move columns/rows and change column/row properties. Right-clicking on a
column/row displays a popup menu. Double-clicking shows a dialog that allows you to edit the
column/row properties.

-10 -
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1125 If a column width or row height is zero, which is the case if a column/row is empty,
then JFormDesigner uses a minimum column width and row height. Columns/rows
having a minimum size are marked with a light-red background in the column/row
header.

1| pext

Selecting columns/rows

You can select more than one column/row. Hold down the Ctrl key (Mac: Command key) and click on
another column/row to add it to the selection. Hold down the Shift key to select the columns/rows
between the last selected and the clicked column/row.

Insert column/row

Right-click on the column/row where you want to insert a new one and select Insert Column / Insert
Row from the popup menu. The new column/row will be inserted before the right-clicked column/row. To
add a column/row after the last one, right-click on the area behind the last column/row.

If the layout manager is FormLayout, an additional gap column/row will be added. Hold down the Shift
key before selecting the command from the popup menu to avoid this.

Besides using the popup menu, you can insert new columns/row when dropping components on
column/row gaps or outside of the existing grid. In the first figure, a new row will be inserted between
existing rows. In the second figure, a virtual grid is shown below/right to the existing grid and a new row
will be added.

a 1 a 1
0| Mame: 0| Mame:
1 DhDh 1| 2hone:
)

3
]

column 0, row 2

Delete columns/rows

Right-click on the column/row that you want delete and select Delete Column / Delete Row from the
popup menu.

If the layout manager is FormLayout, an existing gap column/row beside the removed column/row will
also be removed. Hold down the Shift key before selecting the command from the popup menu to avoid
this.

Split columns/rows

Right-click on the column/row that you want split and select Split Column / Split Row from the popup
menu.

If the layout manager is FormLayout, an additional gap column/row will be added. Hold down the Shift
key before selecting the command from the popup menu to avoid this.

-11 -
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Move columns/rows

The headers allow you to drag and drop columns/rows (incl. contained components and gaps). This
allows you to swap columns or move rows in seconds. Click on a column or row and drag it to the new
location. JFormDesigner updates the column/row specification and the locations of the moved
components.

n Mame:

3| Phone:

Jbte.r:

7| Counfry:

If the layout manager is FormLayout, then existing gap columns/rows are also moved. Hold down the
Shift key before dropping a column/row to avoid this.

Resize columns/rows

To change the (minimum) size of a column/row, click near the right edge of a column/row and drag it.

= IR 5
1] Name: width 60dlu (+20dlu)
1| Bhone: Hint: Press Ctrl to set minimum size
E| EIP [ City:

FormLayout supports minimum and constant column/row sizes. Hold down the Ctrl key to change the
minimum size. TableLayout supports only constant sizes and GridBaglLayout supports only minimum
sizes.

Header symbols

Following symbols are used in the headers:

Column Header
+ Left aligns components in the column.
Right aligns components in the column.
Center components in the column.
Fill (expand) components into the column.
Grow column width.

Group column with other columns. All columns in a group will get the same width.

Row Header
Top aligns components in the row.
Bottom aligns components in the row.
Center components in the row.
Fill (expand) components into the row.
a Baseline aligns components in the row.
a Aligns components above baseline in the row.

Aligns components below baseline in the row.

-12 -
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¥ Grow row height.

il Group row with other rows. All rows in a group will get the same height.

2.3.2 In-place-editing

In-place-editing allows you to edit the text of labels and other components directly in the Design view.
Simply select a component and start typing. JFormDesigner automatically displays a text field that allows
you to edit the text.

Founir] 1 §| | ) Window Tt | 'EIEH_?-J]
I 1

You can also use the Space key or double-click on a component to start in-place-editing. Confirm your
changes using the Enter key, or cancel editing using the Esc key.

In-place-editing is available for all components, which support one of the properties t ext W t hivhenoni c,
text ortitle.

In-place-editing is also supported for the title of Ti t | edBor der and the tab titles of JTabbedPane.

[ceneral . [Gereral]  pptions I Advancedl
Name:
Mame:
. Phone: a "

Ti t 1 edBor der : double-click on the title of the Ti t | edBor der ; or select the component with the
Ti t| edBor der and start in-place-editing as usual.

JTabbedPane: double-click on the tab title; or single-click on the tab, whose title you want to edit and
start in-place-editing as usual.

2.3.3 Keyboard Navigation

Keyboard navigation allows you to change the selection in the designer view using the keyboard. This
allows you for example to edit a bunch of labels using in-place-editing without having to use the mouse.
You can use the following keys:

Key Description

Up move the selection up
Down move the selection down
Left move the selection left
Right move the selection right
Home select the first component
End select the last component

Note: Keyboard navigation is currently limited to one container. You cannot move the selection to
another container using the keyboard.

2.3.4 Menu Designer

The menu designer makes it easy to create and modify menu bars and popup menus. It supports
in-place-editing menu texts and drag-and-drop menu items.

-13 -
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Menu bar structure

IMenu JMenu This figure shows the structure of a menu bar. The horizontal bar on
top of the image is a JMenuBar that contains JMenu components. The
JMenu contains JMenul t em JCheckBoxMenul t em

e d IMenultem JRadi oBut t onMenul t emor Menu Separator components. To create a

[ |
Menultem || JMenultem | sub-menu, put a JMenu into a JMenu.
_vienuttem |

IMenultem

IMenultem

The component palette provides a category "Menus" that contains all components necessary to create
menus.

Creating menu bars

To create a menu bar:

1. add a JMenuBar to a JFrane
2. add JMenus to the JMenuBar and
3. add JMenul t ens to the JMenus

Select the necessary components in the Palette and drop them to the Design view.

h gdd menus nere

@

SRS ) RPN e )
Itext] text|

=dd mer | iterm= Fere

1 |
" o
index

You can freely drag and drop the various menu components to rearrange them.

Creating popup menus
To create a popup menu:

1. add a JPopupMenu to the free area in the Design view and
2. add JMenul t ens to the JPopupMenu

':II"-J"IJIJI' '.I I-

Mame: Unda

E—n
=
[}
=,
=]
=
sl
1
L
3
i)
5
m
- |
il
m
m
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Assign popup menus to components

If you use Java 5 or later, you can assign the popup menu to a component in the properties view using

the "componentPopupMenu" property. Select the component to which you want attach the popup menu
and assign it in the Properties view. Note that you must expand the Expert Properties category to see
the property. Or use search as in the screenshot below.

| = Properties - [ 1% B =

Q, popup
Mame Value

-] Expert Properties (35, 2 matches
(default) -

(default)
(none)

Note that JFormDesigner must run on Java 5 (or later) to use the "componentPopupMenu" property.
Open the JFormDesigner About dialog and check whether it displays "Java 1.5.x" (or later).

2.3.5 Button Groups

Button groups (j avax. swi ng. Butt onG oup) are used in combination with radio buttons to ensure that
only one radio button in a group of radio buttons is selected.

@ preferred I I I P
7 left ) center () dghta@ fl
~ minimum
71 grow | |
~ pixel i:q Qlefaultl— . greferredl- _ mi%‘ugm
F percgntﬁéa ") constant

To visualize the grouping, JFormDesigner displays lines connecting the grouped buttons.

Group Buttons

To create a new button group, select the buttons you want to group, right-click on a selected button and
select Group Buttons from the popup menu.

| | | | |

8@ prefer

+i.-_ Halign:<— 3 &
) mininmy

+'_i-_. v align: ¢ ¥ 4+ %

=) grows
I e B e
w7 pixelw & Bind »
!—I—.I
m) percel Add Event Handler k

Maorph Bean...
Mest in JPanel

Group Buttons L\\’
Ungroup Buttons

You can extend existing button groups by selecting at least one button of the existing group and the
buttons that you want to add to that group, then right-click on a selected button and select Group
Buttons from the popup menu.

Note that the Group Buttons and Ungroup Buttons commands are only available in the context menu

if the selection contains only components that are derived from JToggl eBut t on (JRadi oButt on and
JCheckBox).
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Ungroup Buttons

To remove a button group, select all buttons of the group, right-click on a selected button and select
Ungroup Buttons from the popup menu.

To remove a button from a group, right-click on it and select Ungroup Buttons from the popup menu.

ButtonGroup object

Button groups are non-visual beans. They appear at the bottom of the Structure view and in the Design
view. JFormDesigner automatically creates and removes those objects. You can rename button group
objects.

tructure [+ =]

=[] compSizePanel [FarmlLayout]

(-“ defaultSizeButton (" &default”)
(= prefSizeButton ("&preferred”)
f* minSizeButton {"minim&um”)
L (8 constSizeButton (“cEonstant )]

g ey

If a grouped button is selected, you can see the association to the button group in the Properties view.

| = Properties B+ 8

Mame Value
Name prefSizeButton
Class JxRadioButton

Button Group sizeGroup k‘

2.3.6 JTabbedPane

JTabbedPane is a container component that lets the user switch between pages by clicking on a tab.

After adding a JTabbedPane to your form, it looks like this one:

E

Add panelzfcomponents to create
tabs. To change a tab title,
double-dick at the tab.

To add pages, select an appropriate component (e.g. JPanel) in the palette, move the cursor over the
tabs area of the JTabbedPane and click to add it.

T

text [ktext
g Add pa:@s_."cc-mpc-nents to create |. 1 @"

tabs. T tab title, index1
double-dick at the tab.
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You can see only the components of the active tab. Click on a tab to switch to another page. To change a
tab title, double-click on a tab to in-place-edit it. You can edit other tab properties (tool tip text, icon, ...)
in the Properties view. Select a page component (e.g. JPanel) to see its tab properties.

| = Properties B &+ =

Mame Value
Name generalPanel
Class JPanel
[+ Layout Manager ... FormLayout [default, ...
Tab ToolTip
Tab Icon

Tab Disabled Icon

Tab Mnemonic

Tab Mnemonic Index -1

Tab Enabled true
Tab Background

Tab Foreground

To change the tab order, select a page component (e.g. JPanel) and drag it over the tabs to a new place.
You can also drag and drop page components in the Structure view to change its order.

— =
text | text text|
' Ly

' )

| |

Use an empty border to separate the page contents from the JTabbedPane border. If you are using
JGoodies Forms, it's recommended to use TABBED DI ALOG BORDER. Otherwise use an Enpt yBor der .

text=

text &

text bt

2.3.7 Events

Components can provide events to signal when activity occurs (e.g. button pressed or mouse moved).
JFormDesigner shows events in the Events category in the Properties view.

= Properties &1 lUA A | 4| C o

Mame Value
Name browseButton
Class JEutton
Bindings (©
Events (1
actionPerformed

[ Properties (13, 1 s=t

IDE plug-ins: Click on the Go to Method button () to go to the event handler method in the Java
editor of the IDE.
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Add Event Handlers

To add an event handler to a component, right-click on the component in the Design or Structure view
and select Add Event Handler from the popup menu. Or click the Add Event button (%)) in the
Properties view. The events popup menu lists all available event listeners for the selected components
and is divided into three sections: preferred, normal and expert event listeners.

®m  Browse..,—=
=——=— & Bind g
Add Event Handler » @4 ActionListener - actionPerformed...
Morph Bean... @4 Changelistener - stateChanged...
Mest in JPanel @%  Jtemlistener - itemnStateChanged...
of  Cut Ctri+X | @+ PropertyChangelistener - propertyChange...
=| Copy Ctrl+C
Paste CirleV 'p’ij AncestorListener 3

/.-'
The @ icon in the popup menu indicates that the listener interface will be implemented (e.g.
E-3
javax.swing.ChangelListener). The @ icon indicates that the listener adapter class will be used (e.g.

Lo )
java.awt.event.FocusAdapter for java.awt.event.FocusListener). The icons % and @ are used when the
listener is already implemented.

After selecting an event listener from the popup menu, you can specify the name of the handler method
and whether listener methods should be passed to the handler method in following dialog.

'Igl Add Event Handler we%wl| If you add a PropertyChangeli st ener, you
can also specify a property name (field is not
Add an event handler to selected components visible in screenshot). Then the listener is
Spedify the name of the handler method. added using the method

addPr opert yChangelLi st ener (String
propertyNane, PropertyChangelLi stener

Listener dass: java.awt.event. ActionListener .
|istener).

Listener method: |actionPerformed (ActionEvent)
The "Go to handler method in Java editor"

Handler method: | browseButtonActionPerformed| - . . . )
check box is only available in the IDE plug-ins

Pass listener method parameters to handler method

V| Go to handler method in Java editor

® 0K ] | Cancel

b A

Stand-alone: After saving the form, go to your favorite IDE and implement the body of the generated
event handler method.

If you use the Runtime Library and the Java code generator is disabled, you must implement the handler
method yourself in the target class. See documentation of method For nCr eat or . set Tar get () in the
JFormDesigner Loader API for details.

Remove Event Handlers

To remove an event handler, click the Remove Event button (@). Or right-click on the event and select
Remove Event from the popup menu.

Change Handler Method Name

You can either edit the method name directly in the property table or click the ellipsis button (E|) to open
the Edit Event Handler dialog where you can edit all event options.
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2.4 Palette

The component palette provides quick access to commonly used components (JavaBeans) available for
adding to forms.

&'& Paletts

[+ Selection Mode

a .
i_{ Marguee Selection

[l

The components are organized in categories. Click on a category header to expand
or collapse a category.

- You can add a new component to the form in following ways:
@ Choose Bean...

L= Companents @ Select a component in the palette, move the cursor to the Design or Structure

4 JLabel view and click where you want to add the component.

é;ﬁi:ld # Select Choose Bean, enter the class name of the component in the Choose
(=, Containers Bean dialog, click OK, move the cursor to the Design or Structure view and
[] Panel click where you want to add the component.

[ 7] TabbedPane

[H 15crollPane To add multiple instances of a component, hold down the Ctrl key (Mac:

£3 Windows Command key) while clicking on the Design or Structure view.

£ Menus

3 JGoodies The component palette is fully customizable. Right-click on the palette to add, edit,
{3 Binding remove or reorder components and categories. Or use the Palette Manager.

3 Custom

Toolbar commands

[ Palette Manager Opens the Palette Manager dialog to customize the palette.

Palette Manager

This dialog allows you to fully customize the component palette. You can add, edit, remove or reorder
components and categories.

(2} Palette Manager Iﬁ

Manage the palette

Add, edit, remove and rearrange categories and beans.

Palette items: =]

ag Swing Palette Mew Category...
EID Components
: ' Add Beans...

%g] ILabel (javas, swir

I_ TTextField (iz
ﬁ JComboBox (i

]

[=]

-3 Containers
- 23 Windows

[~ (23 Menus
=
=

|2
il
[=]
m

+- (07 JGoodies
+- (23] Binding

Use drag and drop to rearrange items.

) OK ] [ Cancel
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Choose Bean

You can use any component that follows the JavaBean specification in JFormDesigner. Select Choose
Bean in the palette to open the Choose Bean dialog.

Search tab

On this tab you can search for classes. Enter the first few characters of the class you want to choose until
it appears in the matching classes list. Then select it in the list and click OK.

Following pattern kinds are supported:

non

® Wildcards: "*" for any string; "?" for any character; terminating “<" or
trailing "*"

(space) prevents implicit

® Camel case: "JB" for classes containing "J" and "B" as upper-case letters in camel-case notation,
e.g. JButton or Ji deBut t on; "DaPi" for classes containing "Da"” and "Pi" as parts in camel-case
notation, e.g. Dat ePi cker

The matching classes list displays all classes that match. It is separated into up to three sections:

# History matches: classes found in the history of last used classes. If the search field is empty, the
complete history is displayed. To delete a class from the history, select it and press the Delete key
or right-click on it an select Delete from the popup menu.

® Project matches: classes found in the Classpath specified in the current Project.
@ Palette matches: classes found in the palette.

" = ™
Choose Bean &J

Choose a JavaBean

Select the dass name of a JavaBean that you want to add to the form.

Search | JARs

Search for dass name (? = any character, * = any String, or camel caze):
jbu|
Matching classes: Filter: JavaBean

History matches (1

@

Project matches (4

(® IBusyIndicator (com. formdev. toolkit, swing)
@ JButton (javax.swing)
(8 JButtonBar (com.formdev. toolkit, dizlogs)
Palette matches (1
G JButton (javax.swing)
Is container
[] add to palette category: | Custom Mew, ..
@ Classpath Info OF ] [ Cancel l [ Classpath...
L. A

Filter Menu Options

Use Filter Classes are hidden if they do not match the filter. E.g. if the JavaBean filter is active and the
class is not public or does not have a public constructor.

Show Interfaces Includes interfaces in the list of matching classes.
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JARs tab

On this tab you can select classes that are marked as JavaBean in the JAR's manifest. The provider of the
component JAR can mark some classes as JavaBean in the manifest file. Popular 3rd party component
libraries like MiG Calendar or JIDE components use this to make it easier to find the few classes, which
can be used in GUI builders, in libraries that contain hundreds of classes.

( Choose Bean ﬁ"

Choose a JavaBean
Select the dass name of a JavaBean that you want to add to the form.

Search | JARs

Available JARs in dasspath:

El jide-oss-2.8.4.jar (C:\Java'Libraries)

5 migcalendar-6.8.6.jar (C:'\Java'Librariesz)

i migcalendarbean-6.8.6.jar (C:\ava'Libraries)
JavaBeans in selected JAR:

DateHeaderBean (com.miginfocom.beans) -

DatePickerBean (com. miginfocom. beans)
DateSpinnerBean {com.miginfocom.beans)

DemoDataBean {com.miginfocom.beans) -
[] 1= container
[T] Add to palette category: | Custom Mew, ..
@ Classpath Info [ QK ] [ Cancel l [ Classpath... l

',

See also http://docs.oracle.com/javase/7/docs/technotes/guides/jar/jar.html#Per-Entry_Attributes
Other options
The Is Container check box allows you to specify whether a bean is a container or not.

If you select Add to palette category, the component will be added to the palette category specified in
the following field. Click the New button to create a new category for your components if necessary.

Stand-alone: Use the Classpath button to specify the location of your component classes. Add your JAR
files or class folders.

IDE plug-ins: The classpath specified in the IDE project is used to locate component classes.
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2.5 Structure View

This view displays the hierarchical structure of the components in a form.

ﬁél T = = Each component is shown in the tree with an icon, its name and
5 (form) additional information like layout manager class or the text of a
: label or button. The name must be unique within the form and is

=-[ g this [FormLayout] : .
%z nameLabel (Tizme:” used as variable name in the generated Java code.
----:['P nametField
- §=) phonelabel ("Phone:”] You can edit the name of the selected component in the tree by
-1 phoneField pressing the F2 key. Right-click on a component to invoke
- &5 zipCityLabel ("ZIP [ City: "] commands from the context menu.
[ zipField
1.2 cityField - . The selection in the Structure view and in the Design view is
% countryLabel ("Country: synchronized both ways.
-1 countryField
----- @ bindingGroup (2 bindings

The tree supports multiple selection. Use the Ctrl key (Mac: Command key) to add individual selections.
Use the Shift key to add contiguous selections.

The tree supports drag and drop to rearrange components. You can also add new components from the
palette to the Structure view. Besides the feedback indicator in the structure tree, JFormDesigner also
displays a green feedback figure in the Design view to show the new location.

™ I E

5 (form)

‘é:r-' popupMenu [JPopupMenu]
Cut i (=) cutltem ("Cut”)
e |;§| copyItem {C .
== pasteltem [ Past
Paste

Various overlay icons are used in the tree to indicate additional information:

Icon Description

[C] The component is bound to a Java class. Each component can have its own (nested) class. See Nested
Classes for details.

& The component has bindings assigned to it. The bindings are shown in Bindings view and in the Bindings
category in the Properties view.

3 The component has events assigned to it. The events are shown in the Events category in the Properties
view.

1 The component has custom code assigned to it. See Code Generation properties.

o The variable modifier of the component is set to publ i c. See Code Generation properties.

& The variable modifier of the component is set to def aul t .

L The variable modifier of the component is set to prot ect ed.
o The variable modifier of the component is set to pri vate.
] A property (e.g. JLabel . | abel For ) of the component has a reference to a non-existing component. This

can happen if you e.g. remove a referenced JText Fi el d. In the above screenshot, the component
phonelLabel has a invalid reference.

Toolbar commands

e Expand All Expand all nodes in the structure tree.

= Collapse All Collapse all nodes in the structure tree.
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2.6 Properties View

The Properties view displays and lets you edit the properties of the selected component(s). Select one or
more components in the Design or Structure view to see its properties. If more than one component is
selected, only properties that are available in all selected components are shown.

The properties table displays the component hame, component class, layout manager and constraints
properties, bindings, events, client properties, component properties and code generation properties. The
list of component properties comes from introspection of the component class (JavaBeans).

TP l\_'.-‘ az| ~,)"'| Properties are organlz_ed_ln categories, which you can
H'—‘Name S expand/collapse by clicking on the category name or on the small
Name nameField plus/minus icons. The number of properties in a category and the
Class TTextField number of set properties is displayed near the category name.
+ Layout Constrain... 2, 1, 1, 1, DEFALLT,...
= Bin-:_iings L The category names of component property categories (Properties,
EEd'taEt"E_ & checkBox - selected Expert Properties, etc) are displayed in blue color.
= Even 1
focusLost FieldFocusLost
+ Cliec:ts :rsoperties :rhamE e oruEes Different font styles are used for the prpperty pames. Bold style is
—IProperties (5, 1 5=t used for preferred (often used) properties, plain style for normal
background [] 240, 240, 240 properties and italic style for expert properties. Read-only
columns 20 properties are shown using a gray font color.
= editable false
e = The light gray background indicates unset properties. The shown
font Tahoma 11 i
et B black values are the default values of the component. The white
herizontalAlignment LEADING background indicates set properties. Java code will be generated
text for set properties only. Use Restore Default Value (5%) to unset
L toolTipText

+ Expert Properties (15 a property. Use Set Value to null (=) from the popup menu to
¥ Read-only Properties (33 set a property explicitly to nul | .
1| Code Generation (1:
A small arrow (=) near the property hame indicates that the
property is bound.

Use Group by Category ( T:_3) to organize component properties into three predefined categories
(normal, expert and read-only) and custom categories (defined in BeanInfo). Group by Defining Type (

l"i) organizes component properties into defining types (e.g. JTextField, JTextComponent, JComponent,
Container, Component). Alphabetical (laz) shows all component properties in one category.

Changing property values

The left column displays the property names, the right column the property values. Click on a property
value to edit it.

labelFor
text Name:]  |[@][-
toolTipText

You can either edit a value directly in the property table or use a custom property editor by clicking on
the ellipsis button (i) on the right side. The custom editor pops up in a new dialog. The globe button ([#/
), which is only available for localized forms and string properties, allows you to choose existing strings
from the resource bundle of the form.

The type of the editor depends on the data type of the property. JFormDesigner has built-in property
editors for all standard data types.
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For numbers, a spinner editor makes it easier to increase or decrease the value using the arrow buttons
or Up and Down keys. Press the Enter key to confirm the change; or the Esc key to cancel it.

backaround [] 240, 240, 240

Ak

= editable false

Search for property names

To filter the list of shown properties, select the Show Filter ( Qﬁ) toolbar button. This shows a text field
below the toolbar, where you can enter your filter criteria.

| = Propert: Bl &6

Q. =d|

Mame Value

=1 Properties (3. 2 matches
editable true
enabled true

-] Expert Properties (35, 6 matches
dsshedTextCoor aray
doublefuffered [ false

Common properties and categories

Property/Category Description

Name The name of the component. Must be unique within the form. Used as variable name in the
generated Java code. It is also possible to specify a different variable name in the Code
Generation category.

Class The class name of the component. The tooltip displays the full class name and the class
hierarchy. Click on the value to morph the component class to another class (e.g. JTextField
to JTextArea).

Button Group The name of the button group assigned to the component. This property is only visible for
components derived from JToggl eBut t on (e.g. JRadi oBut t on and JCheckBox).

Layout Manager Layout manager properties of the container component. Click on the plus sign to expand it.
The list of layout properties depends on the used layout manager. This property is only
visible for container components. Click on the value to change the layout manager.

Layout Constraints Layout constraints properties of the component. Click on the plus sign to expand it. The list
of constraints properties depends on the layout manager of the parent component. This
property is only visible if the layout manager of the parent component uses constraints.

Bindings Bindings of the component.
Events Events of the component.
Client Properties Client properties of the component. Click on the plus sign to expand it. This property is only

visible if there are client properties defined in the Client Properties preferences.

Code Generation Code Generation properties of the component.

"(form)" properties

Select the "(form)" node in the Structure view to modify special form properties:

Property Name Description

Form file format The format used to persist the form. See also "Form file format" option in General
preferences.

Set Component If t rue, invokes java.awt.Component.setName() on all components of the form.
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Property Name Description

Names

2.6.1 Layout Manager Properties

Each container component that has a layout manager has layout properties. The list of layout properties
depends on the used layout manager.

Select a container component in the Design or Structure view to see its layout properties in the
Properties view.

&= Properties l{ilaz|<;“|:_‘ﬂ
Mame Value
MName thiz
Class JPanel
alignment CEMTER.
horizontal gap 5
vertical gap 5

- align on baseline (Java 6) [ false

Rindinns 0

This screenshot shows layout manager properties (alignment, horizontal and vertical gap) of a container
that has a FlowLayout.

When you add a container component to a form, following dialog appears and you can choose the layout
manager for the new container. You can also set the layout properties in this dialog.

- 5
(2] MNew JPanel &J

Create a new JPanel

Choose a layout manager and set initial properties,

Layout manager: FlowLayout -
FlowLayout options
Alignment: i left i@ center () bght

") leading ) trailing

[] Align on baseline {Java &)
Horizontal gap: 55 pixel
Vertical gap: 5| pixel

equal gaps

Ok ] [ Cancel

2.6.2 Layout Constraints Properties

Layout Constraints properties are related to layout managers. Some layout managers (FormLayout,
TableLayout, GridBaglLayout, ...) use constraints to associate layout information (e.g. grid x/y) to the
child components of a container.

The list of constraints properties depends on the layout manager of the parent component.
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Select a component in the Design or Structure view to see its constraints properties in the Properties
view.

| = Properties B |+ =
Mame Value
Name label 1
Class JLabel
1, 1, 1, 1, DEFALLT, DEFA. ..
arid x 1
arid ¥ 1
arid width 1
arid height 1
h align DEFAULT
v align DEFALLT
insets 0,0,0,0

Rindinnz 0

This screenshot shows constraints properties of a component in a FormLayout.

2.6.3 Client Properties

What is a client property?

Swings base class for all components, j avax. swi ng. JConponent , provides following methods that allows
you to set and get user-defined properties:

public final Object getdientProperty(Cbject key);
public final void putdientProperty(Object key, Object value);

Some Swing components use client properties to change their behavior. E.g. for JLabel you can disable
HTML display with | abel . put d i ent Property("htnl . di sabl e", Bool ean. TRUE); You can use client

properties to store any information in components. Visit Finally... Client Properties You Can Use on Ben
Galbraith's Blog for a use case.

Define client properties

You can define client properties on the Client Properties page in the Preferences dialog.

Edit client properties

If you've defined client properties, JFormDesigner shows them in the Properties view, where you can set
the values of the client properties.

= prover: VARG
Mame Value
Client Properties (2. 2 ==t
T html.disable true
styleClass smallButton
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2.6.4 Code Generation Properties

This category contains properties related to the Java code generator.

| &= Propertie lu‘ % | y |
Mame Value
-1 Code Generation (13, 1 z=t
Mested Class Na...
Variable Mame nameLabel

Variable Modifiers  private
Use Local Variable [V] frue

Gen, Getter Met. .. false
Component
Property Name Description
Nested Class Name The name of the generated nested Java class. See Nested Classes for details.
Variable Name The variable name of the component used in the generated Java code. By default, it is equal

to the component name.

Variable Modifiers The modifiers of the variable generated for the component. Allowed modifiers: publ i c,
defaul t, protected, private, static and transient. Default is private.

Use Local Variable If t rue, the variable is declared as local in the initialization method. Otherwise at class level.
Default is f al se.

Gen. Getter Method If t rue, generate a public getter method for the component. Default is f al se.

Variable Annotations  Annotations of component variable (Java 5).

(Java 5)

Type Parameters Parameters of component type (Java 5). E.g. MyTypedBean<St ri ng>.

(Java 5)

Custom Create If t rue, create component in createUIComponents() method. Useful if you want use
component factories for or non-default constructors. JFormDesigner generates the
createUIComponents() method, but no component instantiation code. It is your
responsibility to add code to createUIComponents().

Custom Creation Custom code for creation of the component.

Code

Pre-Creation Code Code included before creation of the component.

Post-Creation Code Code included after creation of the component.

Pre-Initialization Code Code included before initialization of the component.

Post-Initialization Code included after initialization of the component.
Code

"(form)" properties

Select the "(form)" node in the Structure view to modify special form properties:

Property Name Description

Generate Java Source If true, generate Java source code for the form. Defaults to "Generate Java source code"

Code option in the Java Code Generator preferences.

Default Variable The default modifiers of the variables generated for components. Allowed modifiers: publi c,
Modifiers defaul t, protected, private, static and transi ent. Default is pri vate.

Default Use Local If t rue, the component variables are declared as local in the initialization method. Otherwise
Variable at class level. Default is f al se.
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Default Gen. Getter
Method

Default Event Handler
Modifiers

Member Variable
Prefix

Use 'this' for member
variables

118n Initialization
Method

118n 'getBundle’
Template

118n 'getString’
Template

118n Key Constants
Class

Binding Initialization
Method

JFormDesigner 5.1 Documentation

Description

If t rue, generate public getter methods for components. Default is f al se.

The default modifiers used when generating event handler methods. Allowed modifiers:
public, defaul t, protected, private, final and static. Default is pri vate.

Prefix used for component member variables. E.g. "m_

If enabled, the code generator inserts 'this.' before all member variables. E.g. t hi s.
nanelLabel . set Text (" Nanme: ") ;

If enabled, the code generator puts the code to initialize the localized texts into a method
initComponentsI18n(). You can invoke this method from your code to switch the locale of a
form at runtime.

Template used by code generator for getting a resource bundle. Default is
Resour ceBundl e. get Bundl e( ${ bundl eNane})

Template used by code generator for getting a string from a resource bundle. Default is
${bundl e}. get Stri ng(${key})

The name of a class that contains constants for resource keys.

If enabled, the code generator puts the code to create bindings into a method
initComponentBindings().

2.6.5 Property Editors

Property editors are used in the Properties view to edit property values.

labelFor
text
toolTipText

(ENTR I ]

You can either edit a value directly in the property table or use a custom property editor by clicking on
the ellipsis button (l=/) on the right side. The custom editor pops up in a new dialog.

The type of the editor depends on the data type of the property. JFormDesigner has built-in property
editors for all standard data types. Custom JavaBeans can provide their own property editors. Take a look
at the API documentation of j ava. beans. Propert yEdi t or, j ava. beans. PropertyDescri pt or and

j ava. beans. Beanl nf o and the JavaBeans topic for details.

Built-in property editors

JFormDesigner has built-in property editors for following data types:

String, String[], bool ean, byt e, char, doubl e, fl oat, i nt, | ong, short, java. | ang. Bool ean,

java.l ang. Byte, j ava. | ang. Character, java. |l ang. C ass, j ava. | ang. Doubl e, j ava. | ang. Fl oat,
java.l ang. I nteger, j ava.l ang. Long, j ava. | ang. Short, j ava. mat h. Bi gDeci mal and
j ava. mat h. Bi gl nt eger

® ActionMap (javax.swing)

® Border (javax.swing)

® Color (java.awt)

® ComboBoxModel (javax.swing)

@ Cursor (java.awt)

® Dimension (java.awt)

® Font (java.awt)

® Icon (javax.swing)
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# Image (java.awt)

#® InputMap (javax.swing)
# Insets (java.awt)

® KeyStroke (javax.swing)
# ListModel (javax.swing)
@ Object (java.lang)

® Paint (java.awt)

# Point (java.awt)

# Rectangle (java.awt)

# SpinnerModel (javax.swing)
@ TableModel (javax.swing)
® TreeModel (javax.swing)

ActionMap (javax.swing)

JFormDesigner 5.1 Documentation

This (read-only) custom editor allows you to see the actions registered for a component in its action map.
The information in the column "Key Stroke" comes from the input map of the component and shows
which key strokes are assigned to actions. The JComponent property "actionMap" is read-only. Expand
the Read-only Properties category in the Properties view to make it visible.

s

actionMap Iﬁj
Key Stroke Action Key = Action
beep javax.swing. text. DefaultEditorkitéBeepaction -
KP_LEFT, LEFT  caret-backward javax.swing. text, DefaultEditorkitéMextvisualPosiionAction =
caret-begin javax.swing. text, DefaultEditorKitéBeginAction
HOME caret-begin-ine javax.swing. text, DefaultEditorkitéBeginLineAction
caret-begin-paragraph  javax.swing. text, DefaultEditorkitsBeginParagraphAction
caret-begin-word javax.swing. text. DefaultEditorkitsBeainWordAction
caret-down javax.swing. text. DefaultEditorkitsMextvisualPositionAction  —
®

Border (javax.swing)

You can either select a border from the combo box in the properties table or use the custom editor.

{detault) el
foreground {default)
toolTipText

{no border)
Expert Properties (=

Read-only Propert] (e dorder, DLU2_BORDER]

[+ Code Generation (1

[TitedBorder, EmptyBaorder(s, 5,5, 5)]
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In the custom editor you can edit all border properties. Use the combo box at the top of the dialog to
choose a border type. In the mid area of the dialog you can edit the border properties. This area is
different for each border type. At the bottom, you can see a preview of the border.

S5

L

[2) border

Border type: TitedBorder -
Border properties

Title: Address

Title justification: Leading -

Title position: Default - .

Title color: [{default}l

Title font: (default)

Border: (default) Edit.
Preview

Address
6] [ OK ] [ Cancel

Color (java.awt)

Following border types are supported:

Bevel Bor der
ConpoundBor der

Dr opShadowBor der (SwingX)
Enpt yBor der

Enpt yBor der (JGoodies)
Et chedBor der

Li neBor der

Mat t eBor der

Sof t Bevel Bor der

Ti t| edBor der

Swing look and feel

custom borders

In the properties table, you can either enter RGB values, color names, system color names or Swing
UIManager color names. When using a RGB value, you can also specify the alpha value by adding a

fourth number.

background

234, 239, 2900 |[=]

The custom editor supports various ways to specify a color. Besides RGB, you can select a color from the

AWT, System or Swing palettes.

(2} background

S5

‘Swatches’| 4gp | RGB | AWT Palette | System Palette | Swing Palette |

Recent:

] -

D Sample Text Sample Text

Ok ] [ Cancel
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This custom editor allows you to specify string values for a combo box.

E model

=)

ComboBox model items:

red
green
1:1'.1E|

b »

@

Each line in the above text field represents a value in the model.

[ OK ] [ Cancel

Cursor (java.awt)

This editor allows you to choose a predefined cursor.

doubieBuffered

focusable

DEFALLT =
DEFALLT

CROSSHAIR
TFYT

Dimension (java.awt)

Either edit the dimension in the property table or use the custom editor.

" 3 !
(2] dimension ﬁ
Width: 54 - pixel
Height: 20 | pixel
@ [ OK l [ Cancel

Font (java.awt)

You can either use absolute fonts, derived fonts or predefined fonts of the look and feel. Derived fonts are
recommended if you just need a bold/italic or a larger/smaller font (e.g. for titles), because derived fonts
are computed based on the current look and feel. If your application runs on several look and feels (e.g.
several operating systems), derived fonts ensure that the font family stays consistent.

In the properties table, you can quickly change the style (bold and italic) and the size of the font.

__fort _____+Bold +3 [Cl@EEENem
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In the custom editor you can choose one of the tabs to specify either absolute fonts, derived fonts or

predefined fonts.

JFormDesigner 5.1 Documentation

B h - )
E font ﬁ E font ﬁ
Font | Derived Fontl 5wing| - Derived Font | Swing
Family: Style: Size: Family
Tahoma Bold Italic |16 = Eamily: (unchanged) -
symbolPS » | | Plain 11 =«
Style
Er— | o | - v
Tempus Sans [TC Italic 14 [ Bold: i) unchanged @ set () dear
Times m L Italic: ) unchanged @ set () dear
Times Mew Roman 18 [= - ) -
Traditional Arabic 20
Size
Trebuchet MS EL 22 |4
Tunga W 24 i@ relative +55
-:“| BT | b - () absolute 16
i
Tahoma 16 Bold Italic Tahoma 16 Bold Italic
Preview Preview
The quick brown fox jumps over th The quick brown fox jumps over th
@ oK J [ Cancel ] @ [ oK J [ Cancel ]
b

Icon (javax.swing) and Image (java.awt)

This custom editor allows you to choose an icon. Either use an icon from the classpath, from the file
system or from the Swing UIManager (look and feel). It is recommended to use the classpath and embed

your icons into your application JAR.

( E icon

|

Image source type:
@ Classpath

™) Eile system (e.g. ct\myapplimage.gif)
() Swing

(7 MNeicon {null)

) Defaulticon

Mame:

Preview

fcom/formdev ftoolkit/resources fpaste_edit. aif

(e.g. fcom/myapp/fimage.gif)

Classpath...

Erowse...

&

Dimension: 16 x 15
Size: 605 Byte

@

J [ Cancel
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InputMap (javax.swing)

This (read-only) custom editor allows you to see the key strokes registered for a component in its input
map. The information in the column "Action" comes from the action map of the component and shows
which action classes are assigned to key strokes. The JComponent property "inputMap" is read-only.
Expand the Read-only Properties category in the Properties view to make it visible.

E inputMap Iﬁ

When Focused (33) | When in Focused Window (0) | When Ancestor of Focused Component {U}ll
key Stroke Action Key = Action

KP_LEFT caret-backward JEVEN. ST
LEFT caret-backward

HOME caret-begin-ine

EMD caret-end-ine

KP_RIGHT caret-forward

RIGHT caret-forward

L. )

Insets (java.awt)

Either edit the insets in the property table or use the custom editor.

r it
[2) insets ﬁ
Top: 2 - pixel
Left: 2 pixel
Bottom: 2 - pixel
Right: 2| pixel
@ [ OK l [ Cancel ]
L. >y

KeyStroke (javax.swing)

In the properties table, you can enter a string representation of the keystroke. E.g. "Ctrl+C" or
"Ctrl+Shift+S".

The custom editor supports two ways to specify a keystroke. Either type any key stroke combination if
the focus is in the first field or use the controls below.
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The KeyStroke editor supports menu shortcut modifier key (Command key on the Mac, Ctrl key
otherwise).

— o
(2] accelerator I&J

Type any key stroke combination:
Ctrl+Shift+5

Key Stroke Properties
Modifiers: ctl [ Alt Shift [|Meta []AltGr
[] Menu shortcut (Meta on Mac 05 ¥, Ctrl otherwise)

Key code: 5 v:

@ [ Ok ] [ Cancel

ListModel (javax.swing)

This custom editor allows you to specify string values for a list.
( E model ﬁj

List model items:

I »

red
green
blue

Each line in the above text field represents a value in the model.

@ [ Ok ] [ Cancel

Object (java.lang)

This editor allows you to reference any (non-visual) JavaBean as a property value. Often used for
JLabel . | abel For .

(|| phoneField -
text (none)
toolTipText -I—- cityField
verticalAlignment i

Expert Properties | [ countryField
Read-only Propert =1 nametField
[+ Code Generation (1]

[ zipField

Paint (java.awt)

This editor allows you to specify a j ava. awt . Pai nt object (used by j ava. awt . G aphi cs2D). Use the
combo box at the top of the dialog to choose a paint type. In the mid area of the dialog you can edit the
paint properties. This area is different for each paint type. At the bottom, you can see a preview of the
paint. For GradientPaint you can click-and-drag the handles in the preview area to move the points.
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paint ﬁw

P

Paint type: GradientPaint v:

Paint properties

Colors:

[ T

Point 1 {x/y): 121 9= pixel
Paint 2 (x/y): 755 335 pixel
Angle: 21 degree
Magnitude: 67 | pixel

Cydic

review

@ [ 0K ] [ Cancel

Po

int (java.awt)

JFormDesigner 5.1 Documentation

Following paint types are supported:

“ Col or
“ & adi ent Pai nt

Either edit the point in the property table or use the custom editor.

( @ point ﬁw
£ 0| pixel
¥ 775 pixel
) [ OK l [ Cancel
Rectangle (java.awt)

Either edit the rectangle in the property table or use the custom editor.

il 3 Y
(2] rectangle ﬁ
X 10 - pixel
¥ 20 -5 pixel
Width 100 = pixel
Height: 20 - pixel
6] [ oK l [ Cancel
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SpinnerModel (javax.swing)

This custom editor allows you to specify a spinner model (used by JSpi nner ). Use the combo box at the
top of the dialog to choose a spinner model type (Number, Date or List). In the mid area of the dialog
you can edit the model properties. This area is different for each model type. At the bottom, you can see
a test spinner where you can test the spinner model.

(2] model &Jw

Model type: Mumber -

Model properties

Mumber type: Integer v:

Initial value: =

[] Minimum: 0k

Maximum: 100

Step size: =
Preview

Here you can test the above settings.

-

Test spinner: ==

) [ OK l [ Cancel

String (java.lang)

Either edit the string in the property table or use the custom editor. Switch the "allow new-line" check
box on, if you want enter new lines.

(3] text )

Lorem ipsum dolor sit amet, consectetuer adipiscing elit,
ged diam nonummy nibh euismod tincidunt ut lacoreet dolore
magna aliguam erat wvolutpat.

[ allow new-ine

Localization

[] Store string in resource bundle (properties fils)

ridle riarme:

m

|m
]
o

By

17

@ OK ] [ Cancel
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String[] (Java.lang)

This custom editor allows you to specify string values for a string array.
i '\
stringArray ﬁ

String array items:

red

i »

green
blue

Each line in the above text field represents a value in the array.

@ QK ] [ Cancel

TableModel (javax.swing)

This custom editor allows you to specify values for a table.

( E model ﬁw

Table model items:

First Name Lazt Name Male B

John Smith 0 Count: 3=
Steve Miller
Insert

Delete

Mave Left

Maove Right

R

-

Count: 2=

Insert

Delete

Move Up

The above table is editable. Select a cell and start typing, Use RETURN to commit,

ESC to cancel and arrow keys to move selection. Maove Down
Column properties
Here you can edit the properties of the column selected in the above table.
Moo |2 Title:  |Male pref, width: | 355
Type: Boolean Values: Edit... Min. width: 355
editable [ resizable Max. width: | 355
5] Ok ] [ Cancel
L "y
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TreeModel (javax.swing)

This custom editor allows you to specify string values for a tree.

s

model

[S=X)

Tree model itemns:

Preview:

colors
red
green
dark
light
blue

-

| colors

Each line in the above text field represents a node in the model.

|Use tabs to indent a line to deeper levels.

@

QK ] [ Cancel
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2.7 Bindings View

The Bindings view displays and lets you edit all bindings of the form. The bindings and binding groups are
shown in the order they will be bound.

This view is not visible by default. It appears at the bottom of the main window when you click the Show
Bindings View button (ﬁ) in the toolbar.

—— e AR Y
Source Target Options
bindingGroup
tteFicld - text I
this - task. description 3 descriptionField - text
enablementBindingGroup
this - §{task | = null} 3 titleField - editable
this - §{task | = null} % descriptionField - editable

The icon between the source and the target columns indicate the update strategy used by the binding:

2 Always sync (read-write)
=+ Only read from source (read-only)
13+ Read once from source (read-once)

Toolbar and context menu commands

= Add Create a new binding.

o Add Group Create a new binding group.

4 Remove Remove the selected bindings.

=] Properties Displays the properties of the selected binding in the Binding dialog.
{‘t Move Up Move the selected bindings up.

{; Move Down Move the selected bindings down.

<J=='{> Link with Designer Links the bindings selection to the active designer.

s Close Closes the Bindings view.

Double-click on a binding item to see its details in the Binding dialog.
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2.8 Error Log View

This view appears at the bottom of the main window if an exception is throw by a bean. You can see
which bean causes the problem and the stack trace of the exception. This makes it much easier to solve
problems when using your own (or 3rd party) beans.

t | Message Exception
Failed to set property TesizeWeight™ to "2°,  IlegalArgumentException: 15plitPane ...

Toolbar commands

T Copy Log Copies all log records to the clipboard.
Clear Log Clears the log.
L;:]'_| Properties Displays the properties of the selected log record in a dialog (see below).
s Close Closes the Error Log view.

Double-click on a log entry to see its details:

(2] Error Properties &J

Date: Apr 1, 2010 7:20:20 PM 1

Component: splitPane 1

Message: Failed to set property “resize\Weight”™ to =27 - [w
Exception Stack Trace:

java.lang.IlegalArgumentException: 15plitfane weight must be between 0 and 1 -

at javax.swing. JSplittane. setResizeWeight(1Splittane. java: 711)

at sun.reflect. NativeMethodAccessorImpl.invoke0(Native Method)

at sun.reflect. NativeMethodAccessarImpl.invoke (MativeMethodAccessarImpl java: 39)

at sun.reflect. DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl. ja

at java.lang.reflect.Method.invoke(Method. java: 597) -
4 [T b

®

How to fix errors

This mainly depends on the error. The problem shown in the above screenshots is easy to fix by setting
resi zeWi ght to a value between 0 and 1.

If the problem occurs in your own beans, use the stack trace to locate the problem and fix it in your

bean's source code. After compiling your bean, click the Refresh Designer button (t’.gh’) in the designer
toolbar to reload your bean.

If you are using 3rd party beans, it is possible that you need to add additional libraries to the classpath.
You should be able to identify such a problem on the kind of exception. In this case, add the needed
libraries to the JFormDesigner classpath of the current Project, and refresh the Design view.
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3 Localization

JFormDesigner provides easy-to-use and powerful localization/internationalization support:

# Externalize and internalize strings.

@ Edit resource bundle strings.

# Create new locales.

@ Delete locales.

# Switch locale used in Design view.

@ In-place-editing strings of current locale.

® Auto-externalize strings.

# Choose existing strings.

# Updates resource keys when renaming components.
® Copies resource strings when copying components.
# Removes resource strings when deleting components.
#® Localization preferences.

# Use .properties or .xml files.

# Fully integrated in undo/redo.

The locales combo box @ in the toolbar allows you to select the locale used in the Design, Structure and
Properties views. If you in-place-edit a localized string in the Design view B, you change it in the current
locale. A small globe @ in front of property values in the Properties view indicates that the string is
localized (stored in a properties file).

[5] JFormDesigner 5.1 - MyProject (=5
Eile Edit View Form Window Help
e -giie-EREC o ER|X| 0O -| Wndws -] =
82 paletts || | [ * AddressPand
E Selection Mode had 1 H 2 il
_-_;_ Marguies Selection | [
& Choose Bean... T
(= Companents 3 [Tel:
';EJ-T'-M 5 |z ort: [
TMextFiekd = l— !
{5 JComboBiox 7 [aend,
=3 JButton : T
| ICheddBox =0 L S
¥ JRadicButton Ll

3 Containsrs foreground I biack
2 Windows hwimnt.alﬁ.liu'mcnt LEADING

- icon
3 Menus
p ; labelFor i!
23 Jooadies [text
2 Bndng toolMipText
(03 Custom - werticalAlignment CENTER

icensad to

& |3 |@

=

o
i

w@Land: |
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Create a new localized form

When creating a new form, you can specify that JFormDesigner should put all strings into a resource
bundle (.properties file). In the New Form dialog select the Store strings in resource bundle check
box, specify a resource bundle name and a prefix for generated keys. If Auto-externalize strings is
selected, then JFormDesigner automatically puts all new strings into the properties file (auto-externalize).
E.g. when you add a JLabel to the form and change the "text" and "toolTipText" properties, both strings
will be put into the properties file.

To localize existing forms use Externalize Strings.

E] Mew Form Iéj1

Create a new Form

Choose a superdass, button bar and layout manager.

Superclass: @ JPanel () IDialeg () JErame () ather

[=)
m
L
3
n
T
(=)
o
T}
el
=}
W]
3
m
m
=1
]
m

Content Pane Layout

Layout manager: [ FormLayout (JGoodies) -
FormLayout options

Mumber of columns: 2

MNumber of rows: 3=

insert gap columns |/ rows

Localization

Store strings in resource bundle (properties file) Auto-externalize strings

Resource bundle name: com.myapp.Bundle Browse. ..

Prefix for generated keys: |AddressPanel [T] no prefix

OK ] [ Cancel ]
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Edit localization settings and resource bundle strings

To edit localization settings and resource bundle strings, select Form > Localize from the main menu or

click the Localize button (“-;'i) in the toolbar. Here you can create or delete locales and edit strings. The
light gray color used to draw the string "Name:" in the table column "German" indicates that the string is
inherited from a parent locale.

(2] Localize @

Localization settings and resource bundles

Edit localization settings, resource bundle strings or add new locales.

Localization settings

Resource bundle name: com.myapp. Bundle Browse...

Resource bundle file: C:\Java\MyProject\srcicommyappBundle. properties

Prefix for generated keys: |AddressFanel Auto-externalize strings

Resource bundles

Strings:
Key = (default) ™8 German (de)
AddressPanel, countryLabel, text Country: Land:
AddressPanel.nameLabel text Mame: Mame: [/\\5
AddressPanel phonelabel, text Phaone: Tel.:
AddressPanel, zipCityLabel text ZIP [ City: PLZ [/ Mame:
Inherited from locale (default)

The above table is editable. Select a cell and start typing. Use RETURN to commit, ESC to cancel and arrow keys to...

[| Show only strings used in active form

@ [ Mew Locale... ] l Delete Locale... Ok ] [ Cancel l l Apply ]

e 4

The Resource bundle name field is used to locate the properties files within the Source Folders of the
current Project. Use the Browse button to choose a resource bundle (.properties file).

In the Prefix for generated keys field you can specify a prefix for generated resource bundle keys. The
format for generated keys is "<prefix>.<componentName>.<propertyName>". You can change the
separator ('.") in the Localization preferences.

If the Auto-externalize strings check box is selected, then JFormDesigner automatically puts all new
strings into the properties file. E.g. when you add a JLabel to the form and change the "text" and
"toolTipText" properties, both strings will be put into the properties file. You can exclude properties from
externalization in the Localization preferences.
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Create new locale

To create a new locale, either select Form > New Locale from the main menu, New Locale (fi—;) from
the toobar or click the New Locale button in the Localize dialog. Select a language and an optional
country. You can copy strings from an existing locale into the new locale, but JFormDesigner fully
supports inheritance in the same way as specified by j ava. uti | . Resour ceBundl e. E.g. if a message is
not in locale "de_AT" then it will be loaded from locale "de".

# !
(2] New Locale L-E_E-J
Create new locale
Specify the language and country of the new locale.
Locale
Language: ™8 German (de) -
Country {optional): (none) -
[] Show all languages and countries
Copy
Copy strings from: (none) -
# [ 0K ] [ Cancel
L. A

Delete a locale

To delete an existing locale, either select Form > Delete Locale from the main menu, Delete Locale (
{?I) from the toobar or click the Delete Locale button in the Localize dialog. Select the locale to delete.

(2] Delete Locale ﬁ

Delete a locale
Select the locale to delete.

Locale: ™ German (de) -

Mote:

@ Deleting a locale deletes the properties file of the specified locale.
& If the properties file contains strings used in other forms, they are lost.
@ Locale deletion can not be undone,

# OK ] l Cancel
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Externalize strings

Externalizing allows you to move strings from a .jfd file to a .properties file. If you want localize existing
forms, start here.

Select Form > Externalize Strings from the main menu or Externalize Strings (19 ) from the toolbar,
specify the resource bundle name, the prefix for generated keys and select/deselect the strings to
externalize. You can exclude properties from externalization in the Localization preferences.

i = ™
Externalize Strings @

Externalize Strings to a resource bundle

Mave strings to @ resource bundle for localization.

Resource bundle name: com.myapp.Bundle Browse...

Prefix for generated keys: | AddressPanel [7] no prefix

Auto-externalize strings on subsequent changes

Externalize strings to locale: (default) -
Strings to externalize:

Component Property Value Key
%0 countryLabel text Country: AddressPanel, countryLabel, text
% nameLabel text Mame: AddressPanel namelabel, text
¥ phoneLabel text Phone: AddressPanel. phonelabel, text
40 zipCityLabel text ZIF | City: AddressPanel. zipCityLabel text
@ [ Select All H Deselect Al K H Cancel
e >y

You can also externalize and internalize properties in the Properties view.

ANl
toolTipTex E7  Restore Default Value
verticalalig

= Expert Prc L SetValue to null
+ Read-onky
[+ Code Gene c@, Bind...
Use Local |
% Edernalize String

@, Internalize String l}

4
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Internalize strings
Internalizing allows you to move strings from a .properties file to a .jfd file.
Select Form > Internalize Strings from the main menu or Internalize Strings ( "31) from the toolbar,

specify the locale to internalize from and select/deselect the strings to internalize. If you internalize all
strings, JFormDesigner asks you whether you want to disable localization for the form.

(- '
ﬁ Internalize Strings ﬁ

Internalize Strings to the form

Move strings from a resource bundle into the form and remove the strings from the resource bundle,

Internalize strings from locale: | {default) v:

Strings to internalize:

| Component = | Property | Value Key
é5) countryLabel text Country: AddressPanel. countryLabel , text
iz nameLabel text Mame: AddressPanel.nameLabel. text
§=) phonelabel text Phone: AddressPanel. phonelabel, text
§m) zipCityLabel text ZIP [ City: AddressPanel, zipCityLabel text
@ [ Select All H Deselect Al [ K J[ Cancel
L. i~y

Choose existing strings

The globe button () in the Properties view, which is only available for localized forms and string
properties, allows you to choose existing strings from the resource bundle of the form.

labelFor
text Name:]  |[®][]
toolTipText

In the Choose Key dialog you can search for keys and/or values. Then select a key in the table and
press OK to use its value in the form.

E Choose Key ﬁj

Choose a key

Search for keys or values and select a key.

Search string (? = any character, * = any String):

Matching strings:
Key - B yalue

AddressPanel. namelabel. text Mame:
AddressPanel, phonelabel, text Tel.:
AddressPanel. zipCityLabel. text PLZ [ Ort:

Search for: (7 Key (7) Value @ Both || Case sensitive

Shaw anly keys that start with key prefix of active form ("AddressPanel.”)

@ [ Mew String... ][geletestring ] [ oK ][ Cancel
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JFormDesigner supports the Beans Binding specification (JSR 295).

A binding syncs two properties: the source property with the target property. The source is usually a

(non-visual) data model object and the target is usually an Ul component (e.g. a JText Fi el d). Initially
the value of the source property is copied to the target property. Depending on the "Update strategy", a
binding tracks changes on both properties and syncs the properties.

Source

public class Task |
public enum Priority

Description:
private String title; /
rivate String descripticn; r
p._ -.g_ p__ - ,{______._.—-—H:areqorv: | Development
private String category = “Nane™;
private Priority priority = Priority.NORMAL; «—> Priorty: HIGH
private boolean completed; 4= Status: c tad

{ HIGH, NORMAL, LOW .}

Target
Title:

Implement new layout manager

We need support for thes new
exciing layout manager,

Beans Binding is open source and not part of the standard Java distribution. You must ship an
additional library with your application. JFormDesigner includes beansbi ndi ng. j ar,

beansbi ndi ng- doc. zi p and beansbi ndi ng-src. zi p in its r edi st folder. For more documentation
and tutorials, visit beansbinding.java.net.

The API documentation is also available here: doc.formdev.com/beansbinding/.

The Bindings view (1] gives a good overview of all bindings in the form. The Show Bindings View button
@ makes this view visible. The Bindings property category © in the Properties view shows the bindings
of the selected component and you can add (), edit (E]) and remove () bindings. Small arrows 4]

indicate that the property is bound. Binding groups are also shown in the Structure view O. The Binding
palette category (6] provides useful components.

[2] JFormDesigner 5.1 - JFormDesigner [P
File Edit View Fgrm Window Help 9
e -w e~ ER| W+ EBR|X| Q- wdus - = 0 @-# | 0@
B Palette ol & = Taskv T Structre B E
[3 Selection Mode + 0 = 1 n | 1-#gx tieLabel (Tide:
4 Marquee Selection " ' . . (i tierieid |
@ Choose Bean... 0| Title: = - - {52 desoiptionLabel (“Descrioton
~ Components b Descripbon: T ;‘.2' desaiptionSaraPane [1SaolPane]
- Ing eategoryLabel ("Category:
i3 JLabel . 17 categoryFickd
[ MextFiekd i priorityLabel (Priont
]| ComboBox 3 priorityField
=3 JButton 2| Eatecory: |l : i statusLabel (75
7 Iheddox ey = i completedCheckBay [Corplsts
" JRadicBution 3| Priority: item 1 = s bindingGroup (7 bindings
oogleButton 45 enablementSindingGroup (10 rangs
:l: I 4| Btathus: Compieted
:i‘m TTextArea [ properties @l‘i B |4 |
= jiummu | Name e value
laz JPESSWON 2 — 2 - - Bindings [
- < Bindk -, &5 4T T = )
] TextPane S FexBiwd FET ecteabie > this - §{task 1= rull
* | JEdtarPane Scarce Target Options editabla L uUeLabef - cnz!;-_f.:::l
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Add/Edit Bindings

There are several ways to add/edit bindings:

JFormDesigner 5.1 Documentation

® Right-click on a component in the Design or Structure view and select Bind from the popup menu.
To edit an existing binding, select a bound property from the Bind submenu.

® Click the Add/Edit Binding button (/EJ) in the Bindings property category in Properties view.
® Right-click on a component property in the Properties view and select Bind from the popup menu.

® Use the Add/Properties command in the Bindings view.

Remove Bindings

To remove existing bindings do one of:

® Click the Remove Binding button () in the Bindings property category in Properties view.

® Use the Remove command in the Bindings view.

Binding Dialog

This dialog enables you to edit all options of one binding.

General tab

[2) Edit Binding

=X

Field

Bind two properties of JavaBean compone...
Specify source, target and options of the binding.

Update source when: _ While typing

50N

i

=t
5

General | Advanced I Table Binding {0 |
Source
Source: ] tasksTable (jzvax.swi...

Source path: zelectedElement. title
Detail path: (use element. toString(]
Target
Target: I tileField (javax.swing...
Target path: text
Update
Update strateqgy: 2 Always sync (read-write)

QK

] I Cancel I I

Apply

Source

Source
path

Detail
path

Target

Target
path

Update
strategy

Update
source
when

Ignore
adjusting
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Description
The source object.

The path (or expression) that identifies the
source property.

The path (or expression) that determines
what is displayed to the user in the target
JList.

(only if target is JList.elements)

The target object.

The path (or expression) that identifies the
target property.

Specifies how the properties are kept
synchronized. Possible values: "Always sync
(read-write)", "Only read from source
(read-only)" and "Read once from source
(read-once)".

Specifies when the source is updated from
the target. Possible values: "While typing",
"On focus lost" and "On focus lost or Enter
key pressed".

(only if target is JTextComponent.text)

If enabled, do not update properties until
the user finished adjusting. E.g. while a
slider is adjusting its value or while the list
selection is being updated.

(only if target is JSlider.value,
JList.selectedElement(s) or
JTable.selectedElement(s))



Advanced tab

(2] Edit Binding

Advanced | Table Binding {g)

Bind two properties of JavaBean compone...
Specify source, target and options of the binding.

Identification and Group
Mame:

Group: bindingGroup

Converter and Validator

Converter: [ (none)

Validator: (none)

Alternate Values

[7] Source null:

[7] Source unreadable:

Target n

(no editor available)

[l=}

Miscellaneous

[7] Bind immediately

Bi

@ [ ok

] [ Cancel

)

[

&ppl?]

e

Table Binding tab

Field

Name

Group

Converter

Validator

Source null

Source
unreadable

Target null

nd

immediately
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Description

The binding's name. Useful for
BindingGroup.getBinding(name).

The group this binding belongs to.

The Converter that converts the value
from source type to target type and vice
versa.

The Validator that validates the value
before passing it from the target back to
the source property.

Used if the value of the source property
is null.

Used if the source property is
unreadable.

Used if the value of the target property is
null.

Bind this binding immediately after
creation. Otherwise bind when the group
is bound.

On this tab you can bind Li st <E> element properties to JTabl e columns. Each item in the source
Li st <E> represents a row in the JTabl e. See JTableBinding for details about table binding.

This tab is enabled if source is an instance of j ava. uti | . Li st <E>, target an instance of
j avax. swi ng. JTabl e and target property is el enent s.

(2] Edit Binding

o |

General I Advanced | Table Binding (4

Specify source, target and options of the binding.

Bind two properties of JavaBean components

Editable
Columns:

Source Path Column Mame Column Class Editable
title Title java.lang. String

category Category java.lang. String

priarity Priarity com.jformdesigner.e...

completed Completed java.lana.Boalean

[ Add Multiple. .. ] [ Add... ] Ed Remowve

@ [ QK l [ Cancel ] [ Apply ]
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Field Description

Editable Specifies whether the table

cells are editable or not.

Columns The column bindings. The
Source Path identifies the
source property in <E>. The
Column Name is shown in
the JTable column header.
Each column binding may
have its own Converter,
Validator and Alternative
Values.


http://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/BindingGroup.html#getBinding%28java.lang.String%29
http://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Converter.html
http://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Validator.html
http://doc.formdev.com/beansbinding/org/jdesktop/swingbinding/JTableBinding.html
http://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Converter.html
http://doc.formdev.com/beansbinding/org/jdesktop/beansbinding/Validator.html
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Path or Expression

To address source or target properties you can either use a path or an expression. Select the Expression
Language button (#{1) left to the input field to enter an expression.

A path (implemented by BeanProperty) uses a dot-separated path syntax. E.g. t ask. tit| e addresses the
title property of an object's t ask property. This is equivalent to source. get Task().getTitle().

An expression (implemented by ELProperty) uses the Expression Language (EL) also known from JSP and
JSF. Besides a dot-separated path syntax to address properties (e.g. "${task. titl e}") it also supports
following operators:

Arithmetic: +, -, *, / and di v, %and nod

Logical: and, &&, or, ||, not, !

Relational: ==, eq, !'=, ne, <, I't, >, gt, <=, ge, >=, le

Empty: enpty

Conditional: A? B: C

EL expression examples:

EL expression Result

${task.title} The titl e property of an object's t ask property.
${firstNane} ${| ast Nane} Concatenation of fi r st Name and | ast Name properties.
${ not her. age > 65} t rue if mother is older than 65, f al se otherwise.
${image. wi dth * inmage. hei ght} Computes the number of pixels of an image.

${i nage. wi dth * inmge. hei ght * 4} Computes the number of bytes of an 32 bit image.

Following words are reserved for the EL and should not be used as identifiers:

and or not div nod
eq ne It gt ge le
true false null enpty instanceof

Data model

The data model used by Beans Binding (JSR 295) is based on the JavaBeans specification. Getters are
necessary to read property values and setters to modify property values. On modifications, property
change events should be fired so that beans binding can update the UI components. E.g.:

public class Task {
private String title;

public String getTitle() {
return title;
}

public void setTitle(String title) {
String oldTitle = this.title;
this.title = title;
changeSupport.firePropertyChange("title", oldTitle, title);
}

private final PropertyChangeSupport changeSupport = new PropertyChangeSupport (this);

public voi d addPropertyChangelLi st ener ( PropertyChangeLi stener |istener) {
changeSupport . addPr opert yChangeLi st ener (1 i stener);
}

public void renpvePropertyChangelLi st ener ( PropertyChangeLi stener |istener) {
changeSupport . renovePr opertyChangeli st ener (1 i stener);
}
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Data model access

The source and target combo boxes in the Binding dialog offer only the components added to the form.
To bind your data model to form components, you could add an instance of your data object to the form
(using Choose Bean), but this requires that the data object is a JavaBean with public null constructor,
which is not always possible.

The preferred way to access the data model for binding is to add a getter for the data model to the form
class. E.g.:

public class TaskVi ewFor m ext ends JPanel {
private Task task;

public Task get Task() {
return task;
}

After compiling the form class, you can use t hi s as binding source and t ask. sonePr operty as binding
source path.

Add a setter to the form class, if the whole data model may change. E.g.:

public class TaskVi ewFor m ext ends JPanel {
public void set Task(Task task) {
Task ol dTask = this.task;
this.task = task;
firePropertyChange("task", ol dTask, task);

How to bind data to a JTable

Beans Binding requires that the data isin ajava. util.Li st (or ObservableList). The type of each data
row should be specified as type parameter to the list. E.g. java. util . Li st <MyDat a>. The data class
should have getters and setters for its values, which can bound to table columns.

Steps to bind a table:

1. Add ajava.util.List component from the Bindings palette category to the form. JFormDesigner
creates a variable for the list in the Java code, but does not assign a value to it. Its up to you, to
assign data to the list before invoking i ni t Conponent s() .

2. Set the Type Parameters property (expand the Class property in Properties view) of the Li st to
your data class (e.g. MyDat a). Make sure that the data class is compiled and in the classpath of the
project.

3. Add a JTabl e to the form.
. Right-click on the table and select Bind > elements from the popup menu, which opens the Binding
dialog.
5. On the General tab, set the source to your Li st object and leave the source path empty.
6. Switch to the Table Bindings tab.
7. Click the Add Multiple button and add columns.

Examples

For examples that use Beans Binding, take a look at the package
com j f or mlesi gner. exanpl es. beansbi ndi ng in the examples.
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5 Projects

Stand-alone edition only. The IDE plug-ins use the source folders and classpath from the IDE projects.

Projects allow you to store project specific options in project files. You can create new projects or open
existing projects using the menubar or toolbar.

When you start JFormDesigner the first time, it creates and opens a default project named
DefaultProject.jfdproj in the folder ${user.home}/.jformdesigner, where ${user.home} is your home
directory. You can see the value of ${user.home} in the About dialog on the System tab.

You can use the default project, but it is recommended to create an own JFormDesigner project in your
project root folder. Then you can commit the JFormDesigner project file into a version control system and
reuse it on other computers. Paths in the project file are stored relative to the location of the project file.
Project files have the extension .jfdproj

Pages

® General
® Source Folders
# Classpath

Project specific preference pages:

# FormLayout (JGoodies)
null Layout
® Localization
Java Code Generator
® Templates
® Layout Managers
# Localization
# Binding
® Code Style
Client Properties

L

L

LI

General

When creating a new project, you can specify a project name and the location where to store the project
file.

[2) Project Properties for MyProject ﬁ

_m General |

--Source Folders
--Classpath Spedify the name and location of your project.
- FarmLayout (JGoodies)
--{GridBagLayout
-l Layout
--Localization
[=-Java Code Generator Description:
E—----Templates
E—----Layu:uut Managers
E—----analization
E—----Binding
‘.Code Style
- {lient Properties

Project name:  |MyProject

Location: C:\JavaiMyProject

[=]
A
]

(% | Restore Defaults OK ] [ Cancel
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Source Folders

On this page, you can specify the locations of your Java source folders. Source folders are the root of
packages containing .java files and are used find resource bundles for localization and are also used by
the Java code generator to generate package statements.

¥ !
E Project Properties for MyProject ﬁ
- General |Source Folders |
~Classpath Spedfy the locations of your Java source folders. These are used to find resource
-FormLayout (1Goodies) bundles and to generate Java package statements.
~GridBagLayout Java source folders:
ol Layout
L ocalization (2 src
[=-Java Code Generator [ testlsrc
--Templates
E—----Layout Managers
--Localization
: Binding

‘...Code Style

Edi Remove
- {Client Properties
(% | Restore Defaults [ OK ] [ Cancel
L. >y

If the folders list is focused, you can use the Insert key to add folders or the Delete key to delete
selected folders.

Classpath

To use your custom components (JavaBeans), JFormDesigner needs to know, from where to load the
JavaBean classes. Specify the locations of your custom JavaBeans on this page. You can add JAR files or
folders containing .class files.

i ™
E Project Properties for MyProject ﬁ

- {zeneral Classpath |
--Source Folders
----- m Specify the locations of your custom JavaBeans. These are used to load JavaBeans
-FarmLayout {JGoodies) | for editing forms and for the component palette.
--{aridBagLayout Classpath:
-l Layout
-Localization (2 dasses n

[=-Java Code Generator {0 libymybeans. jar L

;—----Templates f'j C:Java'librariesjide-oss-2.8.4.jar 1

|"j C:\Java'Libraries\migcalendar-6.8.6.3ar
f'j C:'Java'Libraries\migcalendarbean-6.8.6.jar

[=]

Remov

m

[ OK ] [ Cancel

e "

If the classpath list is focused, you can use the Insert key to add folders/JAR files, the Delete key to
delete selected folders/JAR files, Ctrl+Up keys to move selected items up or Ctri+Down keys to move
selected items down.
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Preferences

This dialog is used to set user preferences.

Stand-alone: Select Window > Preferences from the menu to open this dialog.

Eclipse plug-in: The JFormDesigner preferences are fully integrated into the Eclipse preferences
dialog. Select Window > Preferences from the menu to open it and then expand the node
"JFormDesigner" in the tree.

NetBeans plug-in: NetBeans uses the term "Options" instead of "Preferences". The JFormDesigner
preferences are fully integrated into the NetBeans options dialog. Select Tools > Options from the
menu to open it and then select the "JFormDesigner" page.

IntelliJ IDEA plug-in: IntelliJ IDEA uses the term "Settings" instead of "Preferences". The
JFormDesigner preferences are fully integrated into the Intelli] IDEA settings dialog. Select File >
Settings from the menu to open it and then click the item named "JFormDesigner" in the "IDE
Settings" area.

JBuilder plug-in: The JFormDesigner preferences are fully integrated into JBuilder preferences
dialog. Select Tools > Preferences from the menu to open it.

Pages

General
FormLayout (JGoodies)
GridBaglLayout
null Layout
Localization
Look and Feels
Java Code Generator

® Templates
Layout Managers
Localization
® Binding
Code Style (Stand-alone only)
Client Properties
Native Library Paths
BeanInfo Search Paths
Squint Test
Check for Updates

Import and export preferences

In the Preferences dialog, you can use the Import (==)) button to import preferences from a file and the
Export (==.) button to export preferences to a file. This preferences file is compatible with all
JFormDesigner editions. On export, you can specify what parts of the preferences you want export. You
can also use IDE specific commands:

Eclipse plug-in: You can use the menu commands File > Import and File > Export to import and
export preferences to/from Eclipse preferences files.

NetBeans plug-in: You can use the Import and Export buttons in the Options dialog to import
and export options to/from NetBeans options files.

IntelliJ IDEA plug-in: You can use the menu commands File > Import Settings and File >
Export Settings to import and export settings to/from Intelli] IDEA preferences files.

JBuilder plug-in: Import and export of preferences is not supported.

Note: Each IDE uses its own file format for preferences. The only way to transfer preferences between
the different JFormDesigner editions is to use JFormDesigner preferences files.

Restore defaults

Use the Restore Defaults (E) button to restore the values of the active page to its defaults.
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General

On this page, you can specify general options.

[2) Preferences ﬁ

""" Enera |Genera| |
-~ FarmLayout (JGoodies)
--GridBagLayout Animation
~null Layout Animate layout changes in Design view
-Localization
--Look and Feels Animation speed: () fast @ default ) slow
[=l-Java Code Generator
- Templates Other
Layout Managers Buffer Design view in video memory
Localization
Binding Undo histary size: 1.000 =
L Code Style
-Client Properties Persistence
--Mative Library Paths Form file format: | JFDML - | (applies to new forms only)
--BeanInfo Search Paths : ]
--G&guint Test To change the persistence format of an existing form, open the form,
--Check for Updates select the "(form)™ node in the Structure view and change the "Form file format™
property in the Properties view. Or use the JFormDesigner command-ine toal
to convert the format of many forms.
@ [ Impart... ] [ Export... ] [ Restore Defaults 0K ] [ Cancel
L. A
Option Description Default
Animate layout If enabled, changes to the layout in the Design view are done animated. On
changes in Design
view
Animation speed The speed of the animation. default
Buffer Design view in  If enabled, parts of the Design view are buffered in the video memory of the On
video memory graphics card to improve painting speed.
Undo history size The maximum number of steps in the undo history of a form. 1000
Form file format The format used to persist the form. Since version 5.1, JFormDesigner supports JFDML

the compact, easy-to-merge and fast-to-load persistence format JFDML. To
change the persistence format of an existing form, open the form, select the
"(form)" node in the Structure view and change the "Form file format" property
in the Properties view. Or use the JFormDesigner command-line tool to convert
the format of many forms.
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FormLayout (JGoodies)

On this page, you can specify FormLayout related options.

(2] Preferences ﬁ

- General | FormLayout {JGoodies) |
----- ormLayout (JGoodies)

- {GridBagLayout Configure Project Specific Settings...
il Layout

--Localization Automatically insert/remove gap columns/rows

--Look and Feels

JGoodies Forms version: ' (auto-detect) « .
I:—:I---Je_wa Code Generator - .

L Templates Column/row templates for new columns/rows

é—----Layu:uut Managers Column: [ default default - '

i Localization : :

Binding Column gap: . label component gap du |

‘..Code Style r = 1
~Client Properties Row: ek =)
--Mative Library Paths Row gap: ' line gap dlu |
--BeanInfo Search Paths ) )
~-5guint Test Custom column/row templates

-~ Check for Update
= rpdates Display Mame = Identifier | Column Spedifica...| Row Specification | Gap
my line gap mylinegap  fill: 2dlu fill: 2dlu
my paragraph gap  myparag... fill: 10dlu fill: 10dlu
LayoutMap Initialization Code Ed Remove
@ [ Import... ] [ Export... ] [ Restore Defaults ] [ Ok ] [ Cancel
L. >y
Option Description Default
Automatically If enabled, JFormDesigner automatically inserts/removes gap columns/rows. On
insert/remove gap
columns/rows
JGoodies Forms Required JGoodies Forms version for the created forms. auto-detect
version
Column/row Here you can specify the column and row templates that should be used when
templates for new new columns or rows are inserted.
columns/rows
Column The column template used for new columns. default
Column gap The column template used for new gap columns. label
component
gap
Row The row template used for new rows. default
Row gap The row template used for new gap rows. line gap

Custom column/row If the predefined templates does not fit to your needs, you can define your own

templates here. Since JGoodies Forms 1.2 you can add these custom column/row
templates to the global LayoutMap using the "LayoutMap Initialization Code"
link.
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Custom column/row templates

(2] Add Custom Column/Row Template

Custom column/row template

Display name: |my line gap
Identifier: mylinegap

Lse for: ) columng

Default alignment

Specify the custom columnjfrow template information.

T rows @ both  [V] gaps

JFormDesigner 5.1 Documentation

Size

71 left ) center () right @ fill

) default () preferred

_ minimum

Display name

Identifier

Use for

Default alignment

Size

Resize behavior

Java code

@) constant 2+ | Dialogunits
Lr Dialog units
maximum Dialog units
Resize behavior
@ none
1 grow
Java code (optional)
Column code:
Row code:
# QK ] I Cancel
e A
Option Description

The display name is used within JFormDesigner whenever the template is shown in combo
boxes or popup menus.

The (unique) identifier is stored in form files. Choose a short string. Only letters and digits
are allowed.

Specifies whether the template should be used for columns, rows or both. Also specifies
whether it represents a gap column/row.

The default alignment of the components within a column/row. Used if the value of the
component constraint properties "h align" or "v align" are set to DEFAULT.

The width of a column or height of a row. You can use default, preferred or minimum
component size. Or a constant size. It is also possible to specify a minimum and a maximum
size. Note that the maximum size does not limit the column/row size if the column/row can
grow (see resize behavior).

The resize weight of the column/row.

Optional Java code used by the Java code generator. Useful if you have factory classes for
ColumnSpecs and RowSpecs. Not available for JGoodies Forms 1.2 and later.
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GridBaglLayout

On this page, you can specify GridBaglLayout related options.

E Preferences ﬁ

--zeneral | GridBagLayout |
- FarmLayout (IGoodies)
..... m Configure Project Spedific Settings...

ol Layout
- ocalization
L ook and Feels Column: |Alignment: fil, Min. Size: 0, Resize behavior: 0.0
—I-Java Code Generator
2 --Templates Row: | Alignment: fil, Min, Size: 0, Resize behavior: 0.0
E—----Layu:uut Managers
Localization
Binding

‘.Code Style
- {lient Properties
- Mative Library Paths
--BeanInfo Search Paths

Default properties for new columns/rows

--Squint Test
- Check for Updates L\-y
@ [ Import... ] [ Export... ] [ Restore Defaults ] CK ] [ Cancel
Option Description Default
Default properties for Here you can specify the column and row properties that should be used when
new columns/rows new columns or rows are inserted.
Column The column properties used for new columns. fill:0:0.0
Row The row properties used for new rows. fill:0:0.0

null Layout

On this page, you can specify null layout related options.

E Preferences ﬁ

- General | null Layout |
-~ FarmLayout (JGoodies)
- {GridBagLayout Configure Project Spedific Settings...
----- _
--Localization Snap to grid
--Look and Feels Grid X step: 5k
-Java Code Generator
-~ Templates Grid ¥ step: 515
Hint: Hold down the Shift key in the Design view to temporary disable grid
snapping.
5—----Cu:u:|e Style
- Client Properties
- MNative Library Paths
--Beanlnfo Search Paths
--Squint Test
- Chedk for Updates
@ [ Import... ] [ Export... ] [ Restore Defaults Ok ] [ Cancel
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Option Description Default

Snap to grid If enabled, snap to the grid specified below when moving or resizing a On
component in null layout.

Grid X step The horizontal step size of the grid. 5

Grid Y step The vertical step size of the grid. 5

Localization

On this page, you can specify localization related options.

[2) Preferences

E=X=)

- zeneral

-~ FarmLayout (JGoodies)
- GridBagLayout

-l Layout

.....

--Look and Feels
[=)-Java Code Generator
.- Templates

L.Code Style
- Client Properties
- Mative Library Paths
--BeanInfo Search Paths
--Squint Test
- Check for Updates

| Localization |

Configure Project Spedfic Settings. ..

Rename resource keys when renaming components

Copy localized messages when copying components

Delete localized messages when deleting components

Delete localized messages when internalizing strings

Delete messages only if key prefix is equal to form's key prefix

Insert new messages: next to similar keys (ascending order) -
Format used for generated keys: s{componentMame}S{sep}S{propertyMame}
Separator used for generated keys:

Template for properties files:
# -

# Created by JFormDesigner on £{datce}

Exdude properties from externalization:

contentType (javax. swing. JEditorPane)

nodePropertyMame
@ [ Import... ] [ Export... ] [ Restore Defaults [ Ok, l l Cancel
=y
Option Description Default
Rename resource If enabled, auto-rename resource keys when renaming On
keys when renaming  components and the resource key contains the old component
components name.

Copy localized
messages when
copying components

Delete localized
messages when
deleting components

Delete localized
messages when
internalizing strings

Delete messages only
if key prefix is equal

If enabled, duplicate localized strings in all locales when copying  On
components.

If enabled, auto-delete localized strings, that were used by the On
deleted components, from all locales.

If enabled, auto-delete localized strings, that were internalized, On
from all locales.

If enabled, messages will be auto-deleted only if their key prefix  On
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Option Description Default

to form's key prefix is equal to the key prefix of the form.

Insert new messages Specifies where new messages will be inserted into properties next to similar keys
files. "next to similar keys" inserts new messages next to other (ascending order)

similar keys so that messages that belong together are
automatically at the same location in the properties file. "at the
end of the properties file" always appends new messages to the
end of the properties file.

Format used for Format used when generating a resource key. ${componentName}
generated keys ${sep}${propertyName?}
Separator used for Separator used when generating a resource key.

generated keys

Template for Template used when creating new properties files.
properties files

Exclude properties Specify properties that should be excluded from externalization.
from externalization Useful when using auto-externalization to ensure that some
string property values stay in the Java code.

If the list is focused, you can use the Insert key to add a
property or the Delete key to delete selected properties.

Look and Feels

On this page, you can add Swing look and feels for use in the Design view.

Note: Because Swing is not designed to use two look and feels at the same time (application and Design
view), it can not guaranteed that each look and feel works without problems. The popular Substance and
Synthetica look and feels are currently not supported.

[2) Preferences ﬁ

~General | Look and Feels |
- FarmLayout (JGoodies)

--GridBagLayout Enable Look and Feel switching (requires restart)

-l Layout

~Localization Look and Feels:

""" ook and Feels COE/Motif (com.

=I-Java Code Generator IGoodies Plastc
?----Templates JGoodies Plastic 30 | es,
é‘""'—aY':"_-'t Hanagers JGoodies Plastic XP ( es )
é‘""'—DCEhzath JGoodies Windows | s, dFee
+-Binding Metal (java. e

iCode Style Nimbus

-Client Properties Windows (con
--Mative Library Paths Windows Classic j q.f ssicl ookAndFeel)
--BeanInfo Search Paths
—Chedk for Updates — -
@ [ Impart... ] [ Export... ] [ Restore Defaults ] [ 0K ] [ Cancel
L A
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If the look and feels list is focused, you can use the Insert key to add a look and feel or the Delete key

to delete selected look and feels.

2] Add Look and Feel

|

Look and Feel Information

Mame: Kunststoff

CENSE Code;

Specify the Look and Feel JAR. archive, name and dass name.

Jar path: Java'LookandFeels kunststoffikunststoff.jar

Class name: com.incars. plaf. kunststoff. KunststoffLookAndFeel

@ oK l [ Cancel
k. g
Option Description
Jar path Full path name of the jar file that contains the look and feel classes. Use the Browse button
to select a jar.
Name Name of the look and feel used in the look and feel combo box in the Toolbar.
Class name Class name of the look and feel class (derived from j avax. swi ng. LookAndFeel ).
License code License code for the commercial Alloy Look and Feel.

-61 -


http://www.incors.com/

JFormDesigner 5.1 Documentation

Java Code Generator

On this page, you can turn off the Java code generator and specify other code generation options.

-
[2) Preferences

=X

=

- General

- FarmLayout (IGoodies)
- GridBagLayout

ol Layout

- ocalization

--Look and Feels

v Coce Generator

i-Templates
+~Layout Managers
‘Localization
&-Binding

‘.Code Style

- {lient Properties

- Mative Library Paths
--BeanInfo Search Paths
--Squint Test

- Check for Updates

| Java Code Generator

Configure Project Specific Settings. ..

Generate Java source code

Options

Source compatibility: {use JRE version) =
[] Explicit imports
Container blocks
Comments

[] Edlipse non-nls tags (ff$MNON-MNLS-NE)
[] NetBeans no-i18n tags ({NOI18M)

[7] set component names [ Use 'this' for member variables

Member variables prefi:

Modifiers
Class modifiers: public
Mested dass modifiers: private
Variable modifiers: private
Event handler modifiers: | private

Mote: Class modifiers are used only when generating new dasses. Event handler
modifiers are used only when generating new handler methods.

You can set modifiers per form in the (form) properties.

@ [ Import... H Export... ][RestoreDehults ] [

] [ Cancel

Option

Generate Java source

code

Source compatibility

Explicit imports

Container blocks

Comments

Set component
names

Use Eclipse code
formatter

Eclipse non-nls tags
(//$NON-NLS-n$)

Description

If enabled, JFormDesigner generates Java source code when you save a
form.

Specifies the compatibility of the generated source code. Besides
generating Java 1.x compatible source code, JFormDesigner can also
use Java 5 (or later) features in the generated source code (e.g.
auto-boxing, @Override, etc).

If enabled, the code generator adds explicit import statements (without
'*") for used classes.

If enabled, the code generator puts the initialization code for each
container into a block (enclosed in curly braces).

If enabled, the code generator puts a comment line above the
initialization code for each component.

If enabled, the code generator inserts j ava. awt . Conponent . set Name()
statements for all components of the form.

If enabled, the Eclipse code formatter is used to format the generated
code. (Eclipse plug-in only)

If enabled, the code generator appends non-nls comments to lines
containing strings. These comments are used by the Eclipse IDE to
denote strings that should not be externalized.
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On

Stand-alone: use
JRE version

IDE plug-ins:
use project
setting

Off

On

On

Off

Off

Off



Option

NetBeans no-i18n
tags (//NOI18N)

Use 'this' for member
variables

Member variables
prefix

Class modifiers

Nested class modifiers

Variable modifiers

Event handler
modifiers

Description

JFormDesigner 5.1 Documentation

If enabled, the code generator appends non-nls comments to lines
containing strings. These comments are used by the NetBeans IDE to
denote strings that should not be externalized.

If enabled, the code generator inserts 'this.' before all member
variables. E.g. t hi s. naneLabel . set Text (" Nane: ") ;

Prefix used for component member variables. E.g. "m_

Class modifiers used when generating a new class. Allowed modifiers:

public, defaul t, abstract and final .

Class modifiers used when generating a new nested class. Allowed
modifiers: public, defaul t, protected, private, abstract, final and

static.

The default modifiers of the variables generated for components.
Allowed modifiers: public, defaul t, protected, private, static and

transi ent.

The default modifiers used when generating event handler methods.
Allowed modifiers: public, defaul t, protected, private, final and

static.

You can set additional options per form in the "(form)" properties.

Templates (Java Code Generator)

Default
Off

Off

public

private

private

private

This page contains templates that are used by the code generator when generating a new class. See
Code Templates for details about templates.

,
(2] Preferences

|

--{zeneral

- {GridBagLayout
il Layout
-Localization
L ook and Feels

i Localization
&-Binding
t.Code Style
- {lient Properties
- Mative Library Paths

--Squint Test
- Check for Updates

- FarmLayout (JGoodies)

=l-Java Code Generator

; Layout Managers

--Beanlnfo Search Paths

Templates

Code templates:

Configure Project Spedfic Settings. ..

Compaonent Binding Initialization
Component 118n Initialization
Component Initialization

Empty Class

MNew...

m

[=]

- Remove

Selected template:

Insert Variable - ] [ Reset. ..

${modifiers}eclass ${class_name}

initComponents();
!
3 {component initialization}

F{variables declaration}

${constructer modifiers}s{class_name} () {

${extends_declaration} {

@ [ Impart... ][ Export... ][RestoreDefaults

CK ] [ Cancel
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New: Create a new template for a specific superclass.

Edit: Edit the superclass of the selected user-defined template.

Remove: Remove the selected template. Only allowed for user-defined templates.

Reset: Reset the selected predefined template to the default.

Insert Variable: Insert a variable at the current cursor location into the selected template.

I\ B
(2] New Template Li_E-J
Superdass name: |com.myproject.MyAbstractDialog

Copy from: Class -

Here you can create a new template for a spedfic superdass. It will be used to
generate new dasses that are derived from the spedified superdass or from
subdasses of the spedfied superdass.

[ (04 ][ Cancel ]

Layout Managers (Java Code Generator)

On this page, you can specify code generation options for some layout managers.

(2] Preferences ﬁ

- General | Layout Managers |
- FarmLayout (IGoodies)
- GridBagLayout Configure Project Spedific Settings...
-null Layaut FormLayout (JGoodies)
-l ocalization [] Use PanelBuilder in generated code
--Look and Feels Make anonvmous PanclBuilder TPanel transoarent
[E-Java Code Generator S E e e e e
f—----TempIates _
GridBaglLayout

|:| Use empty GridBagConstraints constructor

GrouplLayout
~Client Properties Generation Style: | (use source compatibility) -
--Native Library Paths ' ’
--BeanInfo Search Paths TableLayout
--Sguint Test
-Check for Updates Package: info.dearthought.layout Reset
@ [ Import... ] [ Export... ] [ Restore Defaults OK ] [ Cancel
Option Description Default
Use PanelBuilder in If enabled, the PanelBuilder class of JGoodies Forms is used for Off
generated code FormLayout.
Use empty If enabled, the empty GridBagConstraints constructor is used in Off
GridBagConstraints the generated code, which is necessary for Java 1.0 and 1.1
constructor compatibility. Since Java 1.2, GridBagConstraints has a constructor
with parameters, which is used by default.
Grouplayout Specifies whether class javax.swing.GrouplLayout is used, which is  use source
Generation Style part of Java 6 and later. Or whether compatibility
org.jdesktop.layout.GrouplLayout from the Open Source Swing (see Java Code
Layout library swing-layout.jar is used, which is also available for Generator preferences
Java 1.4 and 5. page)
TableLayout package Package name used by the Java code generator for TableLayout. info.clearthought.layout
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Option Description Default

Change this only if you have a copy of the original TableLayout in
another package.

Localization (Java Code Generator)

On this page, you can specify code generation options for localization.

(2] Preferences @

~General | Localization |
- FormLayout (JGoodies)

~GridBagLayout Configure Project Specific Settings. ..
-null Layout Initialization

~Localization [7] Generate initComponentsI18n({) method

--Look and Feels
E--Java Code Generator | Copde templates to access resource bundles
;—----Templates

‘Layout Managers

‘getBundle’ template: |ResourceBundle.getBundle{${bundleMame}) Reset

‘getString’ template: | ${bundle}.getString(Skey}) Reszet

E-----Cu:ucle Style
- Client Properties

To change the templates for a specific form only, select the “(form)” node in the
Structure view and expand the "Code Generation™ category in the Properties view.

~Mative Library Paths There you can set these templates for the active form.

--BeanInfo Search Paths

--Squint Test

- Check for Updates

@ [ Import... ] [ Expaort... ] [ Restore Defaults CK l l Cancel

Option Description Default
Generate If enabled, the code generator puts the code to initialize the  Off
initComponentsI18n() localized texts into a method initComponentsI18n(). You can
method invoke this method from your code to switch the locale of a

form at runtime. You can set this options also per form in the
"(form)" properties.

'‘getBundle' template = Template used by code generator for getting a resource ResourceBundle.getBundle
bundle. (${bundleName})

'getString' template Template used by code generator for getting a string from a  ${bundle}.getString(${key})
resource bundle.
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Binding (Java Code Generator)

On this page, you can specify code generation options for Beans Binding (JSR 295).

[2) Preferences ﬁ

~General | Binding |
- FarmLayout (IGoodies)

- GridBagLayout Configure Project Spedfic Settings. ..
-null Layout Initialization

~Localization [] Generate initComponentBindings() method

L ook and Feels
=-Java Code Generator
i-Templates

‘.Code Style
- {lient Properties
- Mative Library Paths
--BeanInfo Search Paths
--Squint Test
- Check for Updates

@ [ Import... ] [ Export... ] [ Restore Defaults CK ] [ Cancel
Option Description Default
Generate If enabled, the code generator puts the code to create bindings into a Off

initComponentBindings() method initComponentBindings(). You can set this options also per form in
method the "(form)" properties.

Code Style (Java Code Generator)

Stand-alone: On this page, you can specify code style options, which are used for code generation.

IDE plug-ins: This page is not available in IDE plug-ins because IDEs already have preferences that
control code style. JFormDesigner uses the code style settings from IDE projects or preferences.

(2} Preferences @

--{zeneral Code Style |
- FarmLayout (JGoodies)
--{GridBagLayout Configure Project Specific Settings. ..
-null Layout Indentation
~Localization Indent size: 45
--Look and Feels ) -

=-Java Code Generator Tab size: =

i~ Templates Use tab character
Layout Managers

?----analization Other

Line separatar: Platform Default - (applies to new files anly)

-

~Client Properties Encoding: Platform Default - {platform default is "windows-12527)

- MNative Library Paths
--Beanlnfo Search Paths
--Sguint Test

- Chedk for Updates

@ [ Import... ][ Export... ][F‘.estoreDefaults Ok ][ Cancel
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Option Description Default
Indent size The number of spaces used for one indentation level. 4

Tab size The number of spaces that represents one tabulation. 4

Use tab character Specifies whether the tab character (\t) is used for indentation or only On

space characters.
Line separator The line separator used for newly created .java and .properies files. Platform default

Encoding The character encoding used for reading and writing Java files. Platform default

Client Properties

On this page, you can can define client properties, which can be set in the Properties view.
E Preferences ﬁ

- General Client Properties |
- FarmLayout (JGoodies)
--{zridBagLayout Configure Project Specific Settings...

-null Layout i ] ] o
Localization Define dient properties that you can setin the Properties view. See

Look and Feels JComponent.putClientProperty() for details about dient properties

=-Java Code Generator Client properties:
o Templates

| Lavout Managers Key = Value Type Component Class

¥ o g hideActionText java.lang.Boolean javax.swing. AbstractButton
:--Localization ) .

himl. disable java.lang.Boolean

~Mative Library Paths
--BeanInfo Search Paths

- Chedk for Updates

|!_!||
1=
m
=1
m

Ok ] [ Cancel

ol
A

@ [ Import... ][ Export... Restore Default
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If the client properties list is focused, you can use the Insert key to add a client property or the Delete
key to delete selected client properties.

(2] Add Client Property Iﬁ

Client property name and type
Specify a JComponent dient property.

fey: hideActionText

Component dass(es): |javax.swing. AbstractButton

If companent dass is not set, the dient property is shown for all components.

Value type: java.lang.Boolean -

Allow only predefined values
Property editor dass:
) 0K ] [ Cancel ]
Option Description
Key The key that identifies the client property.

Component class(es) The component class(es) to which the client property belongs. E.g. if set to
javax.swing.JButton, then the client property is shown in the Properties view for buttons and
for subclasses of JButton. To specify multiple classes, separate them with commas. If not
specified, the client property is shown for all JComponent components.

Value type The type of the client property value. You can select one of the common types (String,
Boolean, Integer, etc) from the combo box or enter the class name of a custom type.

Predefined values If the value type is java.lang.String, then you can specify predefined values for the client
property. When editing the client property in the Properties view, a combo box that contains
these values is shown. The combo box is editable by default. Select the "Allow only
predefined values" check box to make the combo box not-editable.

Property editor class Optional class name of a property editor that should be used when editing the client
property in the Properties view.
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Native Library Paths

On this page, you can specify the locations of custom JavaBeans that use native libraries and you can
specify the folders where to search for the native libraries.

Note: When removing or changing paths, a restart of JFormDesigner (or the IDE) is probably necessary
to make the changes work.

" = ™
(2] Preferences ﬁ

--General Native Library Paths |
- FarmLayout (JGoodies)

- GridBagLayout Specdify the locations of your custom JavaBeans, which use native libraries. And
-null Layout specify the locations of your native libraries.

L ocalization

Classpath for JavaBeans, which uses native libraries:
--Look and Feels

E-Java Code Generator f'j C:\Java'MyProjectlib\gluegen-rt. jar
E—----Templates f'j C:Java'MyProjectlibljogl. jar
E—----Layout Managers

dit... Remove

m
Ir

t-Binding
‘.-Code Style Mative Library Path:
- Client Properties (2= C:\lavaMyProjectlib

-----

--BeanInfo Search Paths

- Check for Updates

m

@ [ Import... ] [ Export... Restore Defaults [ (0]4 ] [ Cancel
Option Description
Classpath for JAR files or folders containing .class files, which are using native libraries. They must be

JavaBeans, which use specified here to ensure that the native libraries are loaded from a special class loader only
native libraries once.

Native Library Path Folders used to search for native libraries.
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BeanInfo Search Paths

On this page, you can specify package names that will be used for finding BeanInfo classes and property

editors.

[2) Preferences

=X

- General

- GridBagLayout
-l Layout
- Localization
--Look and Feels

- Templates

L.Code Style
- {Client Properties
- Mative Library Paths - _
_____ com.myapp.misc. editors
--Squint Test
- Check for Updates

- FarmLayout (1Goodies)

=-Java Code Generator

Beanlnfo Search Paths |

Specify package names that will be used for finding BeanInfo dasses and property
editors. See Introspector, setBeaninfoSearchPath() and
PropertyEditorManager . setEditorSearchPath() for details.

BeanInfo search path:

»

com.myapp.beaninfos
com.myapp. misc. beaninfos |

[, |

Property editor search path:

»

com.myapp.editors

T

@ [ Import... ][ Export... ] Restore Defaults CK ][ Cancel l

Option

BeanInfo search path

Property editor search

path

Description

Package names that will be used for finding BeanInfo classes. Only necessary if the BeanInfo
class is not in the same package as the component class to which it belongs. See
java.beans.Introspector and Introspector.setBeanInfoSearchPath() for details.

Package names that will be used for finding property editors. Only necessary if the property
editor is not in the same package as the property type to which it belongs. See
java.beans.PropertyEditorManager and PropertyEditorManager.setEditorSearchPath() for
details.
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Squint Test

This page allows you to
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specify the squint level for the squint test (menu View > Squint Test).

Preferences

[S5CS)

--{General

- GridBagLayout
il Layout
L ocalization
--Look and Feels

;—----Templates

i-Localization

--Binding
L.Code Style

- {lient Properties

- Check for Updates

- FormLayout (JGoodies)

El-Java Code Generator

i-Layout Managers

- Mative Library Paths
--Beanlnfo Search Paths

Squint Test |

Level: L U 3
Preview:

R T

aiel L (E1 L] B

T

(LI ] BLELLUIRE R i
LR L]
e Tl 8 T IETAE T

R LT

@ [ Import... H Export... ][F‘.estoreDefaults Ok H Cancel

Check for Updates

This page allows you to specify whether JFormDesigner should check for updates and new versions. Click
the "Check Now" button to check for updates immediately.

Preferences

=)

--{zeneral

- {GridBagLayout
-l Layout
L ocalization
--Look and Feels

;—----Templates

i--Localization

--Binding
‘..Code Style

- Client Properties

--Squint Test

- FarmLayout (JGoodies)

El-Java Code Generator

i-Layout Managers

- MNative Library Paths
--BeanInfo Search Paths

|Clleck for Updates |

Check for updates and new versions: Weekly - Check Mow

Last checked for updates on April 7, 2010.

[] Use HTTP proxy to connect to the update server

JrormDesigner Update Available

@ An update for JFormDesigner is available: 5.0.1 (Build 4079).
Change Log Download

@ A (free) new version of JFormDesigner is available: 5.1 (Build 4167).
What's New Download

@ [ Import... H Export... ][F‘.estoreDehults (0]4 H Cancel
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7 IDE Integrations

JFormDesigner is available as stand-alone application and as plug-ins for various IDEs. The IDE plug-ins
completely integrate JFormDesigner into the IDEs.

Following IDE plug-ins are available:

Eclipse plug-in

NetBeans plug-in

IntelliJ IDEA plug-in
* JBuilder plug-in

Other IDEs

If there is no JFormDesigner plug-in for your favorite IDE, you can use the stand-alone edition of
JFormDesigner side by side with your IDE.

IDE plug-in for JDeveloper is already under development.

IDE interworking with stand-alone edition

Care must be taken because you edit the Java source in the IDE and JFormDesigner stand-alone also
modifies the Java source file when generating code for the form. As long as you follow the following rule,
you will never have a problem:

Save the Java file in the IDE before saving the form in JFormDesigner stand-alone.
Your IDE will recognize that the Java file was modified outside of the IDE and will reload it. Some IDEs

ask the user before reloading files, other IDEs silently reload files.

If you have not saved the Java file in the IDE, then you should prevent the IDE from reloading it. In this
case save the Java file in the IDE and then use Generate Java Code in JFormDesigner stand-alone.

JFormDesigner generates Java code when you either Save the form or select Generate Java Code.

JFormDesigner does not hold a copy of the Java source in memory. Every time JFormDesigner generates
Java code, it first reads the Java source file, parses it, updates it and writes it back to the disk.
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7.1 Eclipse plug-in

This plug-in integrates JFormDesigner into Eclipse and other Eclipse based IDEs.

Benefits
Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

® Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within Eclipse. No
need to switch between applications.

# Uses the source folders and classpath of the current Eclipse project. No need to specify them twice.

® The Java code generator updates the .java file in-memory on each change in the designer. You can
design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

# Folding of generated GUI code in Java editor.
® Go to event handler method in Java editor.

® Two-way synchronization of localized strings in designer and in properties file editors. Changing
localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

® Copy needed libraries (JGoodies Forms, TableLayout, etc) to the project and add them to the
classpath of the current Eclipse project. Optionally include source code and javadoc.

# Integrated with Eclipse's Version Control Systems.

@ Integrated into refactoring: Copy, rename, move or delete .jfd files when coping, renaming, moving
or deleting .java files.

User interface

The screenshot below shows the Eclipse main window editing a JFormDesigner form. JFormDesigner adds
the menu Form to the main menu, which is only visible if a JFormDesigner form editor is active.

& Java - MyPropsctise/comymyappeFosmaTutarial jid - Eclipse 30K ESEEEE X
Eile Edit Havigate Sezrch Project Fun Form  Window |Help
Ty J e EEEr ™ . - - £ [l
IS Package ': Hierarchy L. FomsTutonaljfd - |4 FormsTutonial.java ! [ £E Outfine =3
=% "= O - [ Windows =88 @-#18 -
= MyProject [y ceectonmade 1 0 tform)
& src ] - @ his t
L4 Merquee Seleclon ' Eoneral & e GEner alSeparator
H= com @ Choose Bean,.. E " e Asbel
B comumyapp = Components - Ll formDats o companylLal
¥ Addressjava T Label = Contact k contact abel .
ol AddnessPansl java Treutfied . = =
¥ FormsTutonal jevs T Y omibeEon 7 Propelier
¥ ForaTutoralDatejave || =) purton ® | PTIRW] Bower (kW] Properies I ol
= AddressPanel jid = XheckBox - R [roen] [ [rrem] I"_;|.". %| - s
Bundle_de.properties F FadeSotton = — Valoe
o W L
Bundle.properties (3 Contarery Hame p————r
EE FormsTutorialjd (3 Windows Class TextFekd
B JRE Systern Libeary 3 Merws ¥ Layout Comst__
B\ Referenced Libravies ) Jacodies - Bndngs
lik ) heaxf Formlats -
i = ":': Events
- = Properties
&7 JFoemmDesigner Bindings o JFoemDesigner Error Log | 5= ﬁ"’."::d = white
Source Target Options mdtsbiz 7| trus
bandngGroap eribled ¥ o
= font Tahoma 1
farmbats - + ¥ contsctFskd - foreground Il biack: -
1 S

A JFormDesigner editor consists of:

® Toolbar: Located at top of the editor area.
@ Palette: Located at the left side.
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# Design View: Located at the center.

® Structure View: Located in Eclipse's Outline view.

@ Properties View: Located in Eclipse's Properties view.

@ Bindings View: Located below the Design view. This view is not visible by default. Click the Show
Bindings View button (5"?) in the toolbar to make is visible.

® Error Log View: Automatically opens on errors in a view at the bottom.

Creating new forms

To create a new form, click the New JFormDesigner Form (|=_5|;') button in the Eclipse toolbar. You can
also use Ctrl+Shift+V (Mac: Shift+Command+V).

jate  Search Project Run  Window Help
E?L} B0~ EECE

[ MNew JFermDesigner Form (Ctrl+Shift+V) i

You can also create new forms in Eclipse's Package Explorer view. First select the destination package or
folder, then invoke Eclipse's New command and select Other, which opens Eclipse's New dialog. Then
choose JFormDesigner Form from the list of wizards and click Next to proceed.

s 1

%NEW \:IEI&

Select a wizard —

Create a JFormDesigner form

Wizards:
type filter text

(& Class -
¥ Interface

]g Java Project
s Java Project from Existing Ant Buildfile
& JFormDesigner Form

m

2 Plug-in Project -

3 ..
@_} < Back Mext = Finish

e o

If JFormDesigner Form is in the New sub menu, you can choose it directly without the need to open
Eclipse's New dialog.
{£ Package @32 e Hierarchy| = O
==
4 =2 MyProject

PR
2 com
4 1 com.myann

- [¥) Addre MNew 3 ]ﬁ Java Project

4 Elﬁ Addre Go Into 9 Project..

; E@ Forms

- [J] Forms Open in New Window EZ JFormDesigner Form l,}
[ Addre Mnen Tune Hierarche FA O¥  Darlane

In the New JFormDesigner Form dialog, enter the form name (which is also used as class name),
choose a superclass, a layout manager and set localization options.
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Open forms for editing

You can open existing forms the same way as opening any other file in Eclipse. Locate it in Eclipse's
Package Explorer view and double-click it.

Go to Java code / Go to form

JFormDesigner adds a button to Eclipse's main toolbar that enables you to switch quickly from a
JFormDesigner form editor to its Java editor and vice versa. If a form editor is active, then the button is
named Go to Java code (@). If a Java editor is active, then it is named Go to JFormDesigner form (
). You can also use Ctrl+Shift+D (Mac: Shift+Command+D).

ate Search Project Run Form  Window e Refactor Mavigate Search Project Run Windc
ﬁ?@h%'ﬁ"%' 2 0:-JC Iiff'f_sll} B-O0-Q- EH G

rer i3 [ Go to Java code 'FormsTutorial java' l rer &4 l Go to IFormDesigner form 'FormsTutorial jfd' }

Code folding
To move the generated code out of the way, JFormDesigner folds it in the Java editor.

5 FormsTutorial.jfd [J] *FermsTutorialjava =7 =0

pubklic class FormsTutorial extends JPanel | -
= rubklic FormsTutorial() {
initComponents () ;

}
private wvoid initComponents() {
ff JFormDesigner - Component initiaslization - DO NOT MOL
} E
@ Jf JFormDesigner - Varisbkles declaration — DO NOT MODIFY
} -
4 | 1 | 3

Convert NetBeans, IntelliJ IDEA and Abeille forms

You can convert existing NetBeans, IntelliJ IDEA and Abeille forms to JFormDesigner forms. Right-click on
the form file (or any container) and select Convert to JFormDesigner Form.

. ey Emon..
I OptionaPaneljava & Convert to JFormDesigner Form g
B :dd;?:m"fd Refresh (&
I undie_gde.properts . ;
Bundle properties Assign Working Sets... Convert 3 forms te JFormDesigner famma?
Ci FormsTuborsdjid [ Corvet to ForDesigrer Fom. | Generate hva code
CrptionsP anel o Fun As L . 7] Foirn class setends boap-bevel container (Inalll) IDEA farns oriy)
B IRE Systern Library -
B Referenced Libraries Debug As b #| Diglete old form files
lib Team " | Dpen converted forms
i
Compare With b Form files
Replace With 3 Foarn Directory Type
o . - #| ContactForm form MyProgect/sre/comi myapp Inteli) IDEA
et Alt+Ent
- fapeme el #| EemPanelform WyProgect/sro/comy myapp HetBeans
#| OptionsPanielfom MWyProgect/sre/comy myapp Inteli) IDEA
Selectall | | Deselectanl | Lo Cancel
L

When converting an IntelliJ IDEA form, JFormDesigner inserts its own generated GUI code into the
existing Java class and removes IntelliJ IDEA's GUI code.
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Preferences

The JFormDesigner preferences are fully integrated into the Eclipse preferences dialog. Select Window >
Preferences from the menu to open it and then expand the node "JFormDesigner" in the tree. See
Preferences for details.

You can also set project specific settings in the Eclipse project dialog. Select Project > Properties from
the menu to open it and then expand the node "JFormDesigner" in the tree. See Preferences for details.

Keyboard shortcuts

You can assign shortcut keys to some JFormDesigner commands in Eclipse's keys preferences. Select
Window > Preferences > General > Keys to open it. Search for "JFormDesigner" to find
JFormDesigner commands.
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2 NetBeans plug-in

This plug-in integrates JFormDesigner into NetBeans.

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within NetBeans. No
need to switch between applications.

Uses the source folders and classpath of the current NetBeans project. No need to specify them
twice.

The Java code generator updates the .java file in-memory on each change in the designer. You can
design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

Folding and guarding of generated GUI code in Java editor.
Go to event handler method in Java editor.

Two-way synchronization of localized strings in designer and in properties file editors. Changing
localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

Automatically add needed libraries (JGoodies Forms, TableLayout, etc) to the project.
Integrated with NetBeans's Version Control Systems.

Integrated into refactoring: Copy, rename, move or delete .jfd files when coping, renaming, moving
or deleting .java files.

User interface

The screenshot below shows the NetBeans main window editing a JFormDesigner form.
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Eile Edit Wiew Mavigate Scurce Refactor Bun Debug Prefile Team Teools Window Help Q- o trl+
4Bl o ‘ = Ba Gika e . iR .
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A JFormDesigner editor consists of:

Toolbar: Located at top of the editor area.
Palette: Located at the left side.
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# Design View: Located at the center.

@ Structure View: Located at the lower left.

% Properties View: Located at the right side.

@ Bindings View: Located below the Design view. This view is not visible by default. Click the Show
Bindings View button (5"?) in the toolbar to make is visible.

® Error Log View: Automatically opens on errors in a view at the bottom.

Creating new forms

You can create new forms using NetBeans's New File command. In the category Swing GUI Forms
choose JFormDesigner Form and click Next to proceed.

[ New File E=5)

Steps Choose File Type
;- Choose File Type Project: | MyProject -]
Categories: File Types:
1 -
-1} Swing GUIForms | =| Ibialog Form El
i J) JavaBeans Objects B JFrame Form
..[)) AWT GUI Forms [ JinternalFrame Form
=T [ | ranel Form 7
Description:
Creates a new JFormDesigner form, In the wizard, you can specify the =
superclass (panel, dialog, frame, etc), the layout manager and =

Open forms for editing

You can open existing forms the same way as opening any other file in NetBeans. Locate it in NetBeans's
Project view and double-click it.

Source / Design

The Source and Design toggle buttons in the editor toolbar enable you to switch from a JFormDesigner
form editor to its Java editor and vice versa.

Ei] FormsTutorial.java 82
Source | Design || & | @ - | TE;

[+ Selection Mode A L) I

[—
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Convert NetBeans, IntelliJ IDEA and Abeille forms

You can convert existing NetBeans, IntelliJ IDEA and Abeille forms to JFormDesigner forms. Right-click on
the form file (or any container) and select Tools > Convert to JFormDesigner Form.

S MyPraject Cut StrgX ) Convert ta JFomDesigner Form [F==
1 Source Padages Copy Strg+ C
1£5] m Corveart 3 forms by ForsDesigne: foarms?
o Addeasstar
M| Bundie orof Delete Entf ¥ Generate Java code
# [ Bundie_de Refactar N | Form dass extends fop-evel contaner {Inted IDEA forms onfy]
% ContactFon | Deiete old Form fes
5 Forms=Tuton | Oper conmerted forms
ThemPane.| Lo<al Histery b
o OptionsFan Git - Form files:
. Gil
[f Fayground Ferm Deectory Trpe
o Tabbedlish Tock b Apply Diff Pateh V| ContacForm.form CrflavaMyProject/src/com/myapn  Intell] IDEA
[ UrFLteFamn ¥ [emPanel fors CifllavaMyProjeciorcioomimyann  MeBears
ii- [ Librares Add to Faverites ¥| CpsonsPand. form CifllavaMyProjectiscioomimyapn  Indel] IDEA
Convert to JFormDesigner FurLT... Saleet Al Dessiect Al oK 1 Cancel
Create Minit Tests 2

When converting an Intelli] IDEA form, JFormDesigner inserts its own generated GUI code into the
existing Java class and removes IntelliJ IDEA's GUI code.

Options

JFormDesigner uses the term "Preferences" instead of NetBeans "Options". The JFormDesigner
preferences are fully integrated into the NetBeans options dialog. Select Tools > Options from the menu
to open it and then select the "JFormDesigner" page. See Preferences for details.

You can also set project specific options in the NetBeans project dialog. Select File > Project Properties

from the menu to open it and then expand the node "JFormDesigner" in the tree. See Preferences for
details.

Keyboard shortcuts

You can assign shortcut keys to some JFormDesigner commands in NetBeans keymap options. Select
Tools > Options > Keymap to open it. Click on the Category column to sort key bindings by category
name and scroll to the JFormDesigner category.

Unsupported features

Following features from other editions are not supported by the NetBeans plug-in:

@ Use look and feels in Design view.
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7.3 Intelli] IDEA plug-in

This plug-in integrates JFormDesigner into Jetbrains IntelliJ IDEA (Community and Ultimate Editions).

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

® Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within Intelli] IDEA.
No need to switch between applications.

# Uses the source folders and classpath of the current Intelli] IDEA project/module. No need to specify
them twice.

® The Java code generator updates the .java file in-memory on each change in the designer. You can
design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

# Folding of generated GUI code in Java editor.
# Go to event handler method in Java editor.

® Two-way synchronization of localized strings in designer and in properties file editors. Changing
localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

® Copy needed libraries (JGoodies Forms, TableLayout, etc) to the project and add them to the
classpath of the current IntelliJ IDEA project/module. Optionally include source code and javadoc.

@ Assign shortcut keys to most JFormDesigner commands in IntelliJ IDEA's keymap settings.
® Integrated with IntelliJ IDEA's Version Control Systems.

User interface

The screenshot below shows the IntelliJ IDEA main window editing a JFormDesigner form.

B myPraject - | - = o \MyProgect] - [MyProgect] - Larccomimyapp\FormaTutonal gid - Intelll) IDEA 10.5 e 1o
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FET/sG iR A aE | E=re|ldads R | (=
CICTES * | = FemeTuola.fd ) FormsTutoraljava « | ]
vewss| [Mroma x| F = 8K [0 W D - | windwe Em ;s - @~ #| B T B . v
(N ¥ L o = i
GMyProject | - 1 = 3 [] w7 P2 (Form) i
p- . Marquee Selection o—] @ the i
¥ ST P e — L Tt e S A o
i com. myapp i a Company & ] formlwta #3 comparnLabal
B & Address = Compornts . r—— [ E— 3
20 addressPans R Rabe - g contactabe z
AddressPane] & |I TMextFedd = |2 contactFeld =
- [y Resource Burdle Bune 5 MoomboBox #— propellarSeparator E
@ % PormeTutond = Mution 2 PTI [lw] Fower [kid] 3 pikabel
% FormsTusorial il ] MoheckBian - A ] o froei]
@b FomiTutoriaData | | = o o p . s |4 =
@ W JavaGenersPrefsh I ta | §
T3 JavaGeneralPrefsPage = "uﬂcﬂ.ﬂhm e Waks o
T3 TableLayousd. ifd _'lc;" s Hame companyFisd a
2 Taskiew. ifd Cluss TextFieid 3
I e - L1 Windowes [ :::.ul Cons...
Tl mypropcte i j=nm it
N MyProject.iws @ Xioodss !::I-t- =
MyFraect jfiore 33 Bindngy SiPraperties
23 Custom hacknres e ubite
H MR -
¥ SouGE Target Optiong |
& H
5 Brinedingls roiip
gl Frlate -compeny ______________ &lempeyfeld ot |
w | formDats - contact % cortncticd - text
B b TOBo 7 T ormtegrer: fndnge 0| Wormbengner Erver Log

A JFormDesigner editor consists of:

® Toolbar: Located at top of the editor area.
@ Palette: Located at the left side.

# Design View: Located at the center.
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@ Structure View: Located at the upper right. You can hide this view in the editor and show it instead
in IntelliJ IDEA's Structure tool window by unselecting Show Structure in Editor (%3).

@ Properties View: Located at the lower right.

@ Bindings View: Located below the Design view. This view is not visible by default. Click the Show
Bindings View button (ﬁ) in the toolbar to make is visible.

@ Error Log View: Automatically opens on errors in a tool window at the bottom. This view is not
visible in the above screenshot.

Creating new forms

You can create new forms in any of IntelliJ IDEA's project views. First select the destination package or
folder, then invoke IDEA's New command and choose JFormDesigner Form.

| MyProject - [ - e . \MyProject] - Intelli] IDEA 10.5

File Edit Search View GoTo Code Analyze Refactor Build Run Tools Version Control !

EER|SG | IEB QA aH l-rd aE L

5|I =25 MyProject |
D E‘Src ..............................
|E| E‘mm AN .
Mew ¥z} JavaClass
File
Cut Strg+X 5
EJ Package
Copy Strg+C =
JFormDesigper Form
Copy Path  Strg+Umschalt+C

In the New JFormDesigner Form dialog, enter the form name (which is also used as class name),
choose a superclass, a layout manager and set localization options.

Open forms for editing

You can open existing forms the same way as opening any other file in IntelliJ IDEA. Locate it in any of
Intelli]J IDEA's project views and double-click it.

Go to Java code / Go to form

JFormDesigner adds a button to IntelliJ IDEA's main toolbar that enables you to switch quickly from a
JFormDesigner form editor to its Java editor and vice versa. If a form editor is active, then the button is
named Go to Java code (@). If a Java editor is active, then it is named Go to JFormDesigner form (
&). You can also use Ctrl+Shift+D (Mac: Shift+Command+D).

s Version Contral Window Help s Version Control Window Help

:cb|zf‘.a|@ M-‘LJ @@

— |Gotolava code 'FormsTutorial.java' | ———{Go to JFormDesigner form 'FormsTutorial.jfd'}
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Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.

| E& FormsTutorial jfd (Z) FormsTutorial java
01 public FormsTutorial() { ]
initComponents () ;
] 1
= private woid initClomponents() |
=] 1
[+
}

Convert IntelliJ IDEA, NetBeans and Abeille forms

You can convert existing IntelliJ IDEA, NetBeans and Abeille forms to JFormDesigner forms. Right-click on
the form file (or any container) and select Convert to JFormDesigner Form.

PR ER . I -

+i- [y Resour e Bundie Bund Dot Entf D] Convert ta IFermDesigner Form ﬂ
) FormsTusorial
FormsTutorial.jfd Make Module ByProject Cortenrt 3 forms b FormDusignes forms?
B T FormsTiAorialData X +
=i CpaonsPand o | Ganerate lava code

& OpbonsPanel
i OptionsPanel, form
+- (flly External Lisraries & Synchronize ‘OptionsPanel fonm

of| Form dass extends top-eved comtaner (nteli) IDEA forms only)
o | Dt old form fies
o | O corveerted formes

Local History L

Update Copynight...

Form fles:
| Comert o JFermDesigrer Foam...
] Frm Direcinry Type
¥| ContacForm.form C:flavaMyProjectfsc/oom/myapp  Indell] IDEA
¥ [emPanel fons CillavaMyProjectforcioomimyapy  Retbearn

¥ CpbonsPand. form CillavaMyProjectfecimomfmyapy  Iniel] [DEA

select Al | [ Desslect [ o Cancel

When converting an Intelli] IDEA form, JFormDesigner inserts its own generated GUI code into the
existing Java class and removes IntelliJ IDEA's GUI code.

Settings

JFormDesigner uses the term "Preferences" instead of Intelli] IDEA's "Settings". The JFormDesigner
preferences are fully integrated into the IntelliJ IDEA settings dialog. Select File > Settings from the
menu to open it and then click the item named "JFormDesigner" in the "IDE Settings" area. To set project
specific settings, select the item named "JFormDesigner (Project)" in the "Project Settings" area. See
Preferences for details.

Keyboard shortcuts
You can assign shortcut keys to most JFormDesigner commands in IntelliJ IDEA's keymap settings. Select

File > Settings > Keymap to open it. In the actions tree expand All Actions > Plug-ins >
JFormDesigner.
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7.4 JBuilder plug-in

This plug-in integrates JFormDesigner into JBuilder 2006. For JBuilder 2007 (or later) use the Eclipse
plug-in. For JBuilder 2005 use JFormDesigner 4.

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:
# Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within JBuilder. No
need to switch between applications.
# Uses the source folders and classpath of the current JBuilder project. No need to specify them twice.

® The Java code generator updates the .java file in-memory on each change in the designer. You can
design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

# Folding of generated GUI code in Java editor.
# Go to event handler method in Java editor.

® Two-way synchronization of localized strings in designer and in properties file editors. Changing
localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

® Copy needed libraries (JGoodies Forms, TableLayout, etc) to the project and add them to the
classpath of the current JBuilder project. Optionally include source code and javadoc.

@ Convert JBuilder forms (jbInit() methods) to JFormDesigner .jfd files.

User interface

The screenshot below shows the JBuilder main window editing a JFormDesigner form.
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A JFormDesigner editor consists of:

® Toolbar: Located at top of the editor area.

® Palette: Located at the left side.

# Design View: Located at the center.

- 83 -



JFormDesigner 5.1 Documentation

@ Structure View: Located at the lower left.

® Properties View: Located at the right side.

# Bindings View: Located below the Design view. This view is not visible by default. Click the Show
Bindings View button (ﬁﬁ?) in the toolbar to make is visible.

® Error Log View: Automatically opens on errors in a tool window at the bottom. This view is not
visible in the above screenshot.

Creating new forms

You can create new forms using JBuilder's object gallery. Click the New arrow in the toolbar and choose
JFormDesigner Form.

(5 JBuilder 2006 - C:/MyProject/s
File Edit Search Refactor Collaborate

h-EE-BDEHIP-&

E MNew... Skrg+h
B JFormDesigner Form .

Application k‘
% Class

In the New JFormDesigner Form dialog, enter the form name (which is also used as class name),
choose a superclass, a layout manager and set localization options.

Open forms for editing
You can open existing forms the same way as opening any other file in JBuilder. Locate it in JBuilder's
project view and double-click it.

Go to Java code / Go to form

JFormDesigner adds a button to JBuilder's main toolbar that enables you to switch quickly from a
JFormDesigner form editor to its Java editor and vice versa. If a form editor is active, then the button is
named Go to Java code (@). If a Java editor is active, then it is named Go to JFormDesigner form (
cal).

Window  Help Window  Help
@%@ B - @%@ B -
[5o te Java code FormsTutorial. java' | [mo to JFormDesigner Form ‘FormsTuterial jfd |
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Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.

2|24 FormsTutorial

11| (& FormsTutarial

“puhlic class FormsTutorial extends JPahel | A
~ public FormsTutorial() {
initComponents() ;

~ private woid initComponents() {
[ S JFormbesigner - Compohent initializartion - DO NOT MODIFY //GEN-EBEGIN::
'
[ f# JFormDesigner - Wariables declaration - 0O NOT MODIFY //GEN-BEGIN:wariabl.
} v
[a)[=] ¢ | >

Convert JBuilder forms

You can convert existing JBuilder forms to JFormDesigner forms. Right-click on the Java file and select
Convert to JFormDesigner Form.

o e e m
(@) Bundle_de.propert %3 Export a5 & Web Service »
(@) Bunde.propertiss ] I .

i 3,:‘} FormsTutorial.java Delete File “OptionsPanel.java

[k FormsTutorialjfd | <, Clean

OptionsPane]. java e g T

] Mlayqround.jfd - )

4 TabbedDialog, java {? Rebuld
[ Tabbedbialag.jfd [+2| Farmat "OptionsPanel.java”
& UIFLRePanel §fd

€3 Convert to JFormDesigner Form

Convert 1 Form bo JFormDesigner Form?

B Conwert bo JFFormDesigner Form... [

Froperties...

Note: JFormDesigner inserts its own generated GUI code into the existing Java class, but does not

remove JBuilder's GUI code. You have to remove JBuilder's component variables and initialization code
yourself.

Preferences

The JFormDesigner preferences are fully integrated into the JBuilder preferences dialog. Select Tools >
Preferences from the menu to open it. See Preferences for details.

Unsupported features

Following features from other editions are not supported by the JBuilder plug-in:

# Convert NetBeans, IntelliJ IDEA and Abeille forms to JFormDesigner forms.
# Use look and feels in Design view.
# Import and export of preferences.
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8 Layout Managers

Layout managers are an essential part of Swing forms. They lay out components within a container.
JFormDesigner provides support for following layout managers:

BorderLayout
BoxLayout
CardLayout
FlowLayout
FormLayout (JGoodies)
GridBaglLayout
GridLayout
GrouplLayout (Free Design)
HorizontalLayout (SwingX)
Intelli] IDEA GridLayout
null Layout

® TableLayout
VerticalLayout (SwingX)

How to choose a layout manager?

For "normal" forms use either one of the grid-based layout managers (FormLayout, TableLayout or
GridBaglLayout) or use "Free Design" (GroupLayout). Each layout manager has its advantages and
disadvantages. FormLayout and TableLayout are open source and require that you ship an additional
library with your application.

FormLayout has the most features (dialog units, column/row alignment, column/row grouping), but
may have problems if a component span multiple columns or rows and can not handle right-to-left
component orientation.

® TableLayout does not have these limitations, but has fewer features than FormLayout.

GridBaglLayout is the weakest of these three grid-based layout managers, but JFormDesigner hides
its complexity and adds additional features like gaps. Use GridBaglLayout if you cannot use
FormLayout or TableLayout.

GroupLayout (Free Design) allows you to lay out your forms by simply placing components where
you want them. Visual guidelines suggest optimal spacing, alignment and resizing of components.

For button bars use FormLayout, TableLayout, GridBaglLayout or FlowLayout.

To layout a main window, use BorderLayout. Place the toolbar to the north, the status bar to the south
and the content to the center.

For toolbars use JTool Bar , which has its own layout manager (based on BoxLayout).

For radio button groups, BoxLayout may be a good choice. Mainly because JRadi oButt on has a gap
between its text and its border and therefore the gaps provided by FormLayout, TableLayout and
GridBaglLayout are not necessary.
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Change layout manager

You can change the layout manager at any time. Either in the Properties view or by right-clicking on a
container in the Design or Structure view and selecting the new layout manager from the popup menu.

B 5] 78] [# oo :
Name | Value | Add Event Handler b
Name this |
Class TPansl Set Layout Manager L\\? BorderLayout
_ Layout Manager... FormLaInut 1JGnndiesi - Meorph Bean... BoxLayout
Bindings (7! BorderLayout .
Events (0] BoxLayout Mest in JPanel CardLayout
Properties (4] CardLayout FlowLayout
bacdkground FlowLavout of  Cut Strg+X _
barder ¥ - ©  Formlayout (JGoodies)
FormLayout (1Goodies) = Copy Strg+C ]
foreground : h ) GridBaglayout
toolTipText GridBagLayout Paste Strg+V .
.__ | GridLayout GridLayout
Expert Properties ) }
Read-only Propert Grn.upLay;::ut (F'-EF D'_ES'Q';} Duplicate Strg+D GrouplLayout (Free Design)
H Code Generation (1 Harizontallayout {SwingX ) .
Intelii] IDEA GridLayout el - Horizontallayout (Swingx)
null Layout ¥ Delete Entf Intelli) IDEA GridLayout
TablfaLayout . nll Layout
Verticallayout (SwingX)
TableLayout
VerticalLayout (SwingX)
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8.1 BorderLayout

The border layout manager places components in up to five areas: center, north, south, east and west.
Each area can contain only one component.

Morth Pagestart PageStart

West Center East LineStart  Center LineEnd LineEnd  Center LineStart
South PageEnd PageEnd

(absolute positioning) (left-to-right relative positioning) (right-to-left relative positioning)

The components are laid out according to their preferred sizes. The north and south components may be
stretched horizontally. The east and west components may be stretched vertically. The center component
may be stretched horizontally and vertically to fill any space left over.

In addition to absolute positioning, BorderLayout supports relative positioning, which swaps west and
east components if the component orientation of the container is set to right-to-left. To use relative
positioning, first add a component to one of the four side areas and then change the layout constraints
property of that component to PAGE_START, PAGE_END, LINE_START or LINE_END.

BorderLayout is part of the standard Java distribution.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default
horizontal gap The horizontal gap between components. 0
vertical gap The vertical gap between components. 0

Layout constraints properties

A component contained in a container with this layout manager has following layout constraints
properties:

Property Name Description

constraints Specifies where the component will be placed. Possible values: CENTER, NORTH, SOUTH,
EAST, WEST, PAGE_START, PAGE_END, LINE_START and LINE_END.
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8.2 BoxLayout

The box layout manager places components either vertically or horizontally. The components will not
wrap as in FlowLayout.

@ red green blue

This layout manager is used rarely. Take a look at the BoxLayout API documentation for more details
about it.

BoxLayout is part of the standard Java distribution.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description
axis The axis to lay out components along. Possible values: X_AXIS, Y_AXIS, LINE_AXIS and
PAGE_AXIS.
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8.3 CardLayout

The card layout manager treats each component in the container as a card. Only one card is visible at a
time. The container acts as a stack of cards. The first component added to a card layout is the visible
component when the container is first displayed.

CardLayout is part of the standard Java distribution.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default
horizontal gap The horizontal gap at the left and right edges. 0
vertical gap The vertical gap at the top and bottom edges. 0

Layout constraints properties

A component contained in a container with this layout manager has following layout constraints
properties:

Property Name Description

Card Name Identifier that can be used to make a card visible. See API documentation for
Car dLayout . show Cont ai ner, String).
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8.4 FlowLayout

The flow layout manager arranges components in a row from left to right, starting a new row if no more
components fit into a row. Flow layouts are typically used to arrange buttons in a panel.

|0K||Cance|||HEIp| |text||text||text|

| text || text |

FlowLayout is part of the standard Java distribution.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name

alignment

horizontal gap

vertical gap

align on baseline
(Java 6)

Description

The alignment of the layout. Possible values: LEFT, RIGHT, CENTER, LEADING
and TRAILING.

The horizontal gap between components and between the component and the
border of the container.

The vertical gap between components and between the component and the
border of the container.

Specifies whether components are vertically aligned along their baseline.
Components that do not have a baseline are centered.
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8.5 FormlLayout (JGoodies)

FormLayout is a powerful, flexible and precise general purpose layout manager. It places components in
a grid of columns and rows, allowing specified components to span multiple columns or rows. Not all
columns/rows necessarily have the same width/height.

1 3

1| Name:

2| Company:

Unlike other grid-based layout managers, FormLayout uses 1-based column/row indices. And it uses
"real" columns/rows as gaps. Therefore the unusual column/row numbers in the above screenshot. Using
gap columns/rows has the advantage that you can give gaps different sizes.

Use the column and row headers to insert or delete columns/rows and change column/row properties.
JFormDesigner automatically adds/removes gap columns if you add/remove a column/row.

Compared to other layout managers, FormLayout provides following outstanding features:

Default alignment of components in a column/row.
Specification of minimum and maximum column width or row height.

Supports different units: Dialog units, Pixel, Point, Millimeter, Centimeter and Inch. Especially Dialog
units are very useful to create layouts that scale with the screen resolution.

Column/row templates.

Column/row grouping.

FormLayout is open source and not part of the standard Java distribution. You must ship an
additional library with your application. JFormDesigner includes j goodi es-forns. j ar,

j goodi es-forms-javadoc. zi p and j goodi es-forns-src. zi p in its redi st folder. For more
documentation and tutorials, visit www.jgoodies.com or forms.java.net.

The API documentation is also available here: doc.formdev.com/jgoodies-forms/.
IDE plug-ins: If you use FormLayout the first time, the JFormDesigner IDE plug-in ask you whether

it should copy the required library (and its source code and documentation) to the IDE project and
add it to the classpath of the IDE project.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description

columnSpecs Comma separated encoded column specifications. This property is for experts only. Use the
column header instead of editing this property.

rowSpecs Comma separated encoded row specifications. This property is for experts only. Use the row
header instead of editing this property.
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Column/row properties

Each column and row has its own properties. Use the column and row headers to change column/row
properties.

|2 Column Properties &J Field Description
b = Column/Row The index of the column/row. Use the arrow
2L - = buttons (or Alt+Left, Alt+Right, Alt+Up,

Co—pen default defank AIt+_Down keys) to edit the properties of the
previous or next column/row.

Spedification: | default . .
Template FormLayout provides several predefined

templates for columns and rows. Here you can

Default alignment
choose one.

left center right @ fil
Specification The column/row specification. This is a string

Size representation of the options below.
@ default () preferred () minimym Default The default alignment of the components within a
Tl [ . alignment column/row. Used if the value of the component
constant 0f=| | Dialog units - o e
constraint properties "h align" or "v align" are set
rminirmum 0t | Dialog units to DEFAULT.
maximum 0+ | Dialeg units Size The width of a column or height of a row. You
can use default, preferred or minimum
Resize behavior component size. Or a constant size. It is also

possible to specify a minimum and a maximum
size. Note that the maximum size does not limit
arow 115 the column/row size if the column/row can grow
(see resize behavior).

@ none

Grouping
< Resize The resize weight of the column/row.
Group ID: 05| {0 = no group) behavior
@ I ok J | Cancel | | Apply Grouping See column/row grouping for details.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Layout constraints properties

A component contained in a container with this layout manager has following layout constraints
properties:

Property Name Description Default
grid x Specifies the component's horizontal grid origin (column index). 1

grid y Specifies the component's vertical grid origin (row index). 1

grid width Specifies the component's horizontal grid extend (number of columns). 1

grid height Specifies the component's vertical grid extend (number of rows). 1

h align The horizontal alignment of the component within its cell. Possible values: DEFAULT

DEFAULT, LEFT, CENTER, RIGHT and FILL.

v align The vertical alignment of the component within its cell. Possible values: DEFAULT
DEFAULT, TOP, CENTER, BOTTOM and FILL.

insets Specifies the external padding of the component, the minimum amount of 0,0,0,0
space between the component and the edges of its display area.
Note that the insets do not increase the column width or row height (in contrast
to the GridBagConstraints.insets).

Tip: The component context menu allows you to alter the alignment for multi-selections.
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8.5.1 Column/Row Templates

FormLayout provides several predefined templates for columns and rows. You can also define custom

column/row templates in the Preferences dialog.

Column templates

Name

default

preferred

minimum

related gap

unrelated gap
label component gap

glue

button

growing button

Row templates

Name

default

preferred

minimum

related gap
unrelated gap

label component gap

narrow line gap

line gap

paragraph gap

glue

Description

Determines the column width by computing the maximum of all column
component preferred widths. If there is not enough space in the container, the
column can shrink to the minimum width.

Determines the column width by computing the maximum of all column
component preferred widths.

Determines the column width by computing the maximum of all column
component minimum widths.

A logical horizontal gap between two related components. For example the OK
and Cancel buttons are considered related.

A logical horizontal gap between two unrelated components.
A logical horizontal gap between a label and an associated component.

Has an initial width of 0 pixels and grows. Useful to describe glue columns that
fill the space between other columns.

A logical horizontal column for a fixed size button.

A logical horizontal column for a growing button.

Description

Determines the row height by computing the maximum of all row component
preferred heights. If there is not enough space in the container, the row can
shrink to the minimum height.

Determines the row height by computing the maximum of all row component
preferred heights.

Determines the row height by computing the maximum of all row component
minimum heights.

A logical vertical gap between two related components.
A logical vertical gap between two unrelated components.

A logical vertical gap between a label and an associated component.
(requires JGoodies Forms 1.4 or later)

A logical vertical narrow gap between two rows. Useful if the vertical space is
scarce or if an individual vertical gap shall be smaller than the default line gap.

A logical vertical default gap between two rows. A little bit larger than the
narrow line gap.

A logical vertical default gap between two paragraphs in the layout grid. This gap
is larger than the default line gap.

Has an initial height of 0 pixels and grows. Useful to describe glue rows that fill
the space between other rows.
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8.5.2 Column/Row Groups
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Column and row groups are used to specify that a set of columns or rows will get the same width or
height. This is an essential feature for symmetric, and more generally, balanced design.

¥ 1 [ NE 3 o —* 5 o

= ri o
]

1| General

3 Company

5 Contact

7| Propeller
] FTT [kw] ower [ki]

11 R [mm] D [mm]

In the above example, columns [1 and 5] and columns [3 and 7] have the same width.

To visualize the grouping, JFormDesigner displays lines connecting the grouped columns/rows near to the

column and row headers.

Group columns/rows

To create a new group, select the columns/rows you want to group in the header, right-click on a
selected column/row in the header and select Group from the popup menu.

=1 |CE EEE™-

General

3| Company

n

Contact

7| Propeller

8|  PTI [kw] Power [} -
e
11 R [mm] D [n—
L]
=
ke

Note that selected gap columns/rows will be ignored when grouping.

=

Insert Column
Delete Columns
Delete Contents
Split Column

Left
Center
Right
Fill

Grow

Default
Preferred
Minimum
Button
Growing button

Other

Group

Ungroup

Properties...

You can extend existing groups by selecting at least one column/row of the existing group and the
columns/rows that you want to add to that group, then right-click on a selected column/row and select

Group from the popup menu.
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Ungroup columns/lines

To remove a group, select all columns/rows of the group, right-click on a selected column/row and select
Ungroup from the popup menu.

To remove a single column/row from a group, right-click on it and select Ungroup from the popup menu.

Group IDs

A unique group ID identifies each group. When using the header context menu to group/ungroup, you
don't have to care about those IDs. JFormDesigner manages the group IDs automatically.

However it is possible to edit the group ID in the Column/row properties dialog.
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8.6 GridBaglLayout

The grid bag layout manager places components in a grid of columns and rows, allowing specified
components to span multiple columns or rows. Not all columns/rows necessarily have the same
width/height. Essentially, GridBagLayout places components in rectangles (cells) in a grid, and then uses
the components' preferred sizes to determine how big the cells should be.

0 1

0| Mame:

1| Company:

Use the column and row headers to insert or delete columns/rows and change column/row properties.

GridBaglayout is part of the standard Java distribution.

Extensions
JFormDesigner extends the original GridBaglLayout with following features:

Horizontal and vertical gaps

Simply specify the gap size and JFormDesigner automatically computes the

G i dBagConstrai nts. i nsets for all components. This makes designing a form with consistent gaps
using GridBaglLayout much easier. No longer wrestling with Gri dBagConstrai nts. i nsets.

With gaps: Without gaps:
Name: Mame:
Company: Company:

Left/top layout alignment

The pure GridBaglLayout centers the layout within the container if there is enough space.
JFormDesigner easily allows you to fix this problem by switching on two options: align left and align
top.

With layout alignment:  Without layout alignment:

ame:

Name:

Company: Company:

Default component alignment

Allows you to specify a default alignment for components within columns/rows. This is very useful
for columns with right aligned labels because you specify the alignment only once for the column
and all added labels will automatically aligned to the right.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default
horizontal gap The horizontal gap between components. 5
vertical gap The vertical gap between components. 5

align left If true, aligns the layout to the left side of the container. If false, then the true

layout is centered horizontally.

align top If true, aligns the layout to the top side of the container. If false, then the true
layout is centered vertically.
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These four properties are JFormDesigner extensions to the original GridBagLayout. However, no
additional library is required.

Column/row properties

Each column and row has its own properties. Use the column and row headers to change column/row

o |

“) bottom @ fil

") aboye baseline

0 pixel

0

1 below baseline  (Java g)

l [ Cancel

J

Apply

properties.
- -

[2) Column Properties Li_E-J [2) Row Properties
Column: ] et Riow: ]
Default alignment Default alignment

7 left 7 center (7) right @ Al 7 top () center
~) baseline
Size
Minimurm: 05| pixel Size
Minirmur:
Resize behavior
@ none Resize behavior
) grow 1 @ none
“) grow 15
@ [ ok |[ canesl |[ appy | @ [ o
L A b
Field Description

Column/Row

Default alignment

Size

Resize behavior

The index of the column/row. Use the arrow buttons (or Alt+Left, Alt+Right, Alt+Up,
Alt+Down keys) to edit the properties of the previous or next column/row.

The default alignment of the components within a column/row. Used if the value of the
constraints properties "h align" or "v align" is DEFAULT.

The minimum width of a column or height of a row.

The resize weight of the column/row.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Layout constraints properties

A component contained in a container with this layout manager has following layout constraints

properties:

Property Name
grid x

grid y

grid width

grid height

h align

v align

weight x

Description Default
Specifies the component's horizontal grid origin (column index). 0
Specifies the component's vertical grid origin (row index). 0
Specifies the component's horizontal grid extend (number of columns). 1
Specifies the component's vertical grid extend (number of rows). 1

The horizontal alignment of the component within its cell. Possible values: DEFAULT
DEFAULT, LEFT, CENTER, RIGHT and FILL.

The vertical alignment of the component within its cell. Possible values: DEFAULT
DEFAULT, TOP, CENTER, BOTTOM, FILL, BASELINE (Java 6), ABOVE_BASELINE

(Java 6) and BELOW_BASELINE (Java 6).

Specifies how to distribute extra horizontal space. 0.0
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Property Name Description Default

weight y Specifies how to distribute extra vertical space. 0.0

insets Specifies the external padding of the component, the minimum amount of 0,0,0,0
space between the component and the edges of its display area.

ipad x Specifies the internal padding of the component, how much space to add to the 0
minimum width of the component.

ipad y Specifies the internal padding, that is, how much space to add to the minimum 0
height of the component.

In contrast to the GridBagConstraints API, which uses anchor and fill to specify the alignment and

resize behavior of a component, JFormDesigner uses the usual h/ v al i gn notation.

Tip: The component context menu allows you to alter the alignment for multi-selections.
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8.7 GridLayout

The grid layout manager places components in a grid of cells. Each component takes all the available
space within its cell, and each cell is exactly the same size.

This layout manager is used rarely.

GridLayout is part of the standard Java distribution.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default
columns The number of columns. Zero means any number of columns.
rows The number of rows. Zero means any number of rows.

Note: If the number of rows is non-zero, the number of columns specified is
ignored. Instead, the number of columns is determined from the specified
number or rows and the total number of components in the layout.

horizontal gap The horizontal gap between components. 0

vertical gap The vertical gap between components. 0
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8.8 GrouplLayout (Free Design)

The goal of the group layout manager is to make it easy to create professional cross platform layouts. It
is designed for GUI builders, such as JFormDesigner, to use the "Free Design" paradigm. You can lay out
your forms by simply placing components where you want them. Visual guidelines suggest optimal
spacing, alignment and resizing of components.

Animation
Animate layout changes in Design view
Animation speed: fast ;_g;ﬂ; slowy
—E—n
Other
Buffer Desiagn view in video memary

-

Undo history size: 1,000 =

GroupLayout has been developed by the NetBeans team and is also used by the NetBeans GUI Builder
(formerly Project Matisse). They provide a comprehensive tutorial on designing GUIs using GrouplLayout,
which is also suitable for JFormDesigner: http://www.netbeans.org/kb/60/java/quickstart-gui.html

GrouplLayout is part of the standard Java distribution since Java 6. If you need to run your application
also on Java 5 or 1.4, you can use the open-source Swing Layout Extension library, which is
compatible to the Java 6 GrouplLayout, but uses different package names. Change the option
"GrouplLayout Generation Style" in the Layout Managers (Java Code Generator) preferences if
necessary.

The API documentation is available here: doc.formdev.com/grouplayout/.
IDE plug-ins: If you use GrouplLayout from the Swing Layout Extension library the first time, the

JFormDesigner IDE plug-in ask you whether it should copy the required library (and its source code
and documentation) to the IDE project and add it to the classpath of the IDE project.

Alignment guidelines

Alignment guidelines appear only when adding or moving components. They indicate the preferred
positions to which components snap when releasing the mouse button.

Insets are the preferred spacings between components and their container.

[

i
\Sr/mp at the preferred distance from the container's left border.
Snap at the preferred distance from the container's upper border,

Offsets are the preferred spacings between adjacent components.

Mame:

s

&

|Sr|ap at the large preferred distance from a component on the left,
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Baseline alignment is the preferred relationship between adjacent components that display text.

Mame: [}
i

rAIign on the baseline with another component.

Edge alignments (top, bottom, left and right) are possible relationships between adjacent components.

Mame: I}

i
Tﬁ«lign with the top side of another component,

Mame:

s

*)
|Aligr1 with the left side of another component, |

Indentation alignment is a special alignment relationship in which one component is located below
another and offset slightly to the right.

Mame:

s

+]

Indent the component.
Snap at the small preferred distance frem a component above,

Anchoring indicators

Anchoring indicators appear when components have snapped into position. They illustrate the alignment
and relationship among components.

—E—n [ ] =
alames Mame:p-—-&

Anchors connecting components to their container or to adjacent components are represented by small
semi-circular indicators with dashed lines.
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The designer context menu provides following GroupLayout specific commands:

Command

|+

[+

Align in
column/row

Align

Anchor

Horizontal Auto
Resizing

Vertical Auto
Resizing

Same Width

Same Height

Set Default Size

Space Around
Component

Duplicate

Description

Aligns the selected components left/right/top/bottom/center in column/row.

Aligns the selected components left/right/top/bottom.

Changes the anchoring of the selected components. A component is usually horizontally
anchored left/right and vertically anchored top/bottom. Anchoring connects a component
to a container edge or a neighborhood component edge.

Makes the selected components resize horizontally at runtime if the container size
changes.

Makes the selected components resize vertically at runtime if the container size
changes.

Makes the selected components all the same width. If one of the selected components is
already in a group of "Same Width" components, the other components are added to the
existing group. To remove components from a group, select them and then execute this
command. Grouped components are marked with a small indicator.

H H

Ok | | Cancel

Makes the selected components all the same height. See "Save Width" command for
more details.

Makes the selected components have its default size.

Changes the empty space around the selected component.

Duplicates the selected components and places the new components below the original
components. Use Ctrl+Left, Ctrl+Right, Ctrl+Up or Ctrl+Down keys to place the
duplicated components left, right, above or below the original components.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name

honors visibility

Description Default

Specifies whether component visibility is considered when positioning and sizing true
components. If true, non-visible components are not treated as part of the
layout. If false, components are positioned and sized regardless of visibility.

Layout constraints properties

A component contained in a container with this layout manager has following layout constraints
properties:

Property Name

horizontal size

vertical size

Description Default

Specifies the component's horizontal size in pixel or Default. If set to Default, Default
the component's preferred width is used.

Specifies the component's vertical size in pixel or Default. If set to Default, the  Default
component's preferred height is used.
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Property Name Description Default
horizontal resizable Specifies whether the component is horizontal resizable. false
vertical resizable Specifies whether the component is vertical resizable. false
top space Specifies the top empty space.

left space Specifies the left empty space.

bottom space Specifies the bottom empty space.

right space Specifies the right empty space.

top space resizable Specifies whether the top empty space is vertical resizable. false
left space resizable Specifies whether the left empty space is horizontal resizable. false
bottom space Specifies whether the bottom empty space is vertical resizable. false
resizable

right space resizable Specifies whether the right empty space is horizontal resizable. false

- 104 -



JFormDesigner 5.1 Documentation

8.9 HorizontalLayout (SwingX)

The horizontal layout manager places components horizontally. The components are stretched vertically
to the height of the container. The components will not wrap as in FlowLayout.

| QK || Cancel || Help |

HorizontalLayout is part of the SwingX open source project and not part of the standard Java
distribution. You must ship an additional library with your application. The JFormDesigner distribution
does not include the SwingX library. For downloads, documentation and tutorials, visit
swingx.java.net (or www.swinglabs.org).

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default

gap The horizontal gap between components. 0
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8.10 1IntelliJ IDEA GridLayout

The IntelliJ IDEA grid layout manager places components in a grid of columns and rows, allowing
specified components to span multiple columns or rows. Not all columns/rows necessarily have the same

width/height.

Note: The Intelli] IDEA grid layout manager is supported to make it easier to migrate forms, which were
created with Intelli] IDEA's GUI builder. If you never used it, it is recommended to use one of the other

grid-based layout managers.
0 1

0 Mame:

1| Company:

o |

(%]

Use the column and row headers to insert or delete columns/rows and change column/row properties.

Use horizontal and vertical spacers, which are available in the Palette, to define space between

components.

IntelliJ IDEA GridLayout is open source and not part of the standard Java distribution. You must ship
an additional library with your application. JFormDesigner includes intel lij_fornms_rt.jar and
intellij fornms_rt_src.zipinitsredist folder. For more documentation and tutorials, visit

www.jetbrains.com/idea/.

IDE plug-ins: If you use Intelli]J IDEA GridLayout the first time, the JFormDesigner IDE plug-in ask
you whether it should copy the required library (and its source code) to the IDE project and add it to

the classpath of the IDE project.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description

horizontal gap The horizontal gap between components. If -1, then inherits gap from parent
container that also uses Intelli] IDEA GridLayout, or uses 10 pixel.

vertical gap The vertical gap between components. If -1, then inherits gap from parent
container that also uses Intelli]J IDEA GridLayout, or uses 5 pixel.

same size horizontally If true, all columns get the same width.
same size vertically If true, all rows get the same height.

margin Size of the margin between the containers border and its contents.

Layout constraints properties

Default

=il

=il

false
false

0,0,0,0

A component contained in a container with this layout manager has following layout constraints

properties:
Property Name Description
grid x Specifies the component's horizontal grid origin (column index).
grid y Specifies the component's vertical grid origin (row index).
grid width Specifies the component's horizontal grid extend (number of columns).
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Property Name Description Default
grid height Specifies the component's vertical grid extend (number of rows). 1
fill Specifies how the component fills its cell. Possible values: None, Horizontal, None

Vertical and Both.

anchor Specifies how the component is aligned within its cell. Possible values: Center,  Center
North, North East, East, South East, South, South West, West and North West.

indent The indent of the component within its cell. In pixel multiplied by 10. 0

align grid with parent If true, align the grid of nested containers, which use IntelliJ IDEA GridLayout, false
with the grid of this container.

horizontal size policy = Specifies how the component affects horizontal resizing behavior. Possible Can Shrink
values: Fixed, Can Shrink, Can Grow, Want Grow and combinations. and Can
Grow
vertical size policy Specifies how the component affects vertical resizing behavior. Possible values: Can Shrink
Fixed, Can Shrink, Can Grow, Want Grow and combinations. and Can
Grow
minimum size The minimum size of the component. =ik, =il
preferred size The preferred size of the component. =il, =il
maximum size The maximum size of the component. -1, -1
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8.11 null Layout

null layout is not a real layout manager. It means that no layout manager is assigned and the
components can be put at specific x,y coordinates.

MName:

It is useful for making quick prototypes. But it is not recommended for production because it is not
portable. The fixed locations an sizes do not change with the environment (e.g. different fonts on various
platforms).

Preferred sizes

JFormDesigner supports preferred sizes of child components. This solves one common problem of null

layout: the component sizes change with the environment (e.g. different fonts on various platforms).
Unlike other GUI designers, no additional library is required.

Grid

To make it easier to align components, the component edges snap to an invisible grid when moving or
resizing components. You can specify the grid step size in the Preferences dialog. To temporary disable
grid snapping, hold down the Shift key while moving or resizing components.

Keyboard

You can move selected components with Ctrl+ArrowKey and change size with Shift+ArrowKey.

Aligning components

The align commands help you to align a set of components or make them same width or height.

Sege”
e = Align Left Alt+Left
'._: = Align Center Alt+Home
#] = Align Right Alt+Right
T Align Top Alt+Up
- Align Middle Alt+End
iih Align Bottom Alt+Down
= Same Width Ctrl+ Alt+Right
Tl same Height Ctrl+Alt+ Down

E3

Make Horizontal Space Equal  Ctrl+ Alt+Left
+  Make Vertical Space Equal Ctri+Alt+Up

The dark blue handles in the above screenshot indicate the first selected component.

Command Description
= Align Left Line up the left edges of the selected components with the left edge of the first selected
component.
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Align Center

Align Right

Align Top

Align Middle

Align Bottom

Same Width
Same Height
Make Horizontal

Space Equal

Make Vertical
Space Equal
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Description

Horizontally line up the centers of the selected components with the center of the first
selected component.

Line up the right edges of the selected components with the right edge of the first selected
component.

Line up the top edges of the selected components with the top edge of the first selected
component.

Vertically line up the centers of the selected components with the center of the first
selected component.

Line up the bottom edges of the selected components with the bottom edge of the first
selected component.

Make the selected components all the same width as the first selected component.
Make the selected components all the same height as the first selected component.

Makes the horizontal space between 3 or more selected components equal. The leftmost
and rightmost components stay unchanged. The other components are horizontally
distributed between the leftmost and rightmost components.

Makes the vertical space between 3 or more selected components equal. The topmost and
bottommost components stay unchanged. The other components are vertically distributed
between the topmost and bottommost components.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name

auto-size

Description Default

If true, computes the size of the container so that all children are entire visible.
If false, the size of the container in the Design view is used.

true

Layout constraints properties

A component contained in a container with this layout manager has following layout constraints
properties:

Property Name

X

width

height

Description Default
The x coordinate of the component relative to the left corner of the 0
container.

The y coordinate of the component relative to the upper corner of the 0
container.

The width of the component in pixel or Preferred. If set to Preferred, Preferred
the component's preferred width is used.
The height of the component in pixel or Preferred. If set to Preferred, Preferred

the component's preferred width is used.
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8.12 TableLayout

The table layout manager places components in a grid of columns and rows, allowing specified
components to span multiple columns or rows. Not all columns/rows necessarily have the same
width/height.

A column/row can be given an absolute size in pixels, a percentage of the available space, or it can grow
and shrink to fill the remaining space after other columns/rows have been resized.

0 1

0| Mame:

1| Company:

Use the column and row headers to insert or delete columns/rows and change column/row properties.

TableLayout is open source and not part of the standard Java distribution. You must ship an
additional library with your application. JFormDesigner includes Tabl eLayout . j ar,

Tabl eLayout - j avadoc. j ar and Tabl eLayout -src. zi p in its redi st folder. For more documentation
and tutorials, visit tablelayout.java.net.

The API documentation is also available here: doc.formdev.com/tablelayout/.
IDE plug-ins: If you use TableLayout the first time, the JFormDesigner IDE plug-in ask you whether

it should copy the required library (and its source code and documentation) to the IDE project and
add it to the classpath of the IDE project.

Extensions

JFormDesigner extends the original TableLayout with following features:
Default component alignment
Allows you to specify a default alignment for components within columns/rows. This is very useful
for columns with right aligned labels because you specify the alignment only once for the column
and all added labels will automatically aligned to the right.

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default
horizontal gap The horizontal gap between components. 5
vertical gap The vertical gap between components. 5
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Each column and row has its own properties. Use the column and row headers to change column/row

properties.
. Field
|2 Column Properties &J
Column/Row
Column: 0 5
Default alignment
left center right @ fil D(.afault
alignment
- Size
minimurm
arow
pixel 0| pixel
percentage 0 %
@ [ oK ] | Cancel || Apply

Tip: The column/row

Layout constraints properties

Description

The index of the column/row. Use the arrow
buttons (or Alt+Left, Alt+Right, Alt+Up,
Alt+Down keys) to edit the properties of the
previous or next column/row.

The default alignment of the components within
a column/row. Used if the value of the
constraints properties "h align" or "v align" is
DEFAULT.

Specifies how TableLayout computes the
width/height of a column/row.

context menu allows you to alter many of these options for multi-selections.

A component contained in a container with this layout manager has following layout constraints

properties:

Property Name
grid x

grid y

grid width

grid height

h align

v align

Description Default
Specifies the component's horizontal grid origin (column index). 0
Specifies the component's vertical grid origin (row index). 0
Specifies the component's horizontal grid extend (number of columns). 1
Specifies the component's vertical grid extend (number of rows). 1

The horizontal alignment of the component within its cell. Possible values: DEFAULT
DEFAULT, LEFT, CENTER, RIGHT and FILL.

The vertical alignment of the component within its cell. Possible values: DEFAULT

DEFAULT, TOP, CENTER, BOTTOM and FILL.

In contrast to the TableLayoutConstraints API, which uses [column1,rowl,column2,row2] to specify the
location and size of a component, JFormDesigner uses the usual [x,y,width,height] notation.

Tip: The component context menu allows you to alter the alignment for multi-selections.
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8.13 VerticalLayout (SwingX)

The vertical layout manager places components vertically. The components are stretched horizontally to
the width of the container.

Cancel

Help

Ptk

VerticalLayout is part of the SwingX open source project and not part of the standard Java
distribution. You must ship an additional library with your application. The JFormDesigner distribution
does not include the SwingX library. For downloads, documentation and tutorials, visit
swingx.java.net (or www.swinglabs.org).

Layout manager properties

A container with this layout manager has following layout manager properties:

Property Name Description Default

gap The vertical gap between components. 0
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9 Java Code Generator

JFormDesigner can generate and update Java source code. It uses the same name for the Java file as for
the Form file. E.g.:

C:\ MyProj ect\src\com nyproj ect\ Wl coneDi al og. j fd (form file)
C.\ MyProj ect\src\com nyproj ect\ Wl coneDi al og. j ava (java file)

Stand-alone: Before creating new forms, you should specify the locations of your Java source folders in
the Project dialog. Then JFormDesigner can generate valid package statements. For the above example,
you should add C:\ MyPr oj ect\src.

IDE plug-ins: The source folders of the IDE projects are used.

If the Java file does not exist, JFormDesigner generates a new one. Otherwise it parses the existing Java
file and inserts/updates the code for the form and adds import statements if necessary.

Stand-alone: The Java file will be updated when saving the form file.

IDE plug-ins: If the Java file is opened in the IDE editor, it will be immediately updated in-memory on
each change in JFormDesigner. Otherwise it will be updated when saving the form file.

JFormDesigner uses special comments to identify the code sections that it will generate/update. E.g.:

/1 JFornDesigner - ... //GEN-BEGQ N: i ni t Conponent s
/1 JFormDesigner - ... //CEN END:initConponents

The starting comment must contain GEN- BEG N:. <keywor d>, the ending comment GEN- END: <keywor d>.
These comments are NetBeans compatible. The text before GEN- BEG N and GEN- END (in the same line)
does not matter. JFormDesigner uses the following keywords:

Keyword Description
name

initComponents Used for code that instantiates and initializes the components of the form.
variables Used for code that declares the class level variables for components.

initI18n Used for code that initializes localized component properties if option "Generate
initComponentsI18n() method" is enabled in the Localization (Java Code Generator) preferences or
"(form)" properties.

initBindings Used for code that initializes bindings if option "Generate initComponentBindings() method" is
enabled in the Localization (Java Code Generator) preferences or "(form)" properties.
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9.1 Nested Classes

One of the advanced features of JFormDesigner is the generation of nested classes. Normally, all code for
a form is generated into one class. If you have forms with many components, e.g. a JTabbedPane with

some tabs, it is not recommended to have only one class. If you hand-code such a form, you would
create a class for each tab.

In JFormDesigner you can specify a nested class for each component. You do this in the Code Generation

category in the Properties view. JFormDesigner automatically generates/updates the specified nested
classes. This allows you to program more object-oriented and makes your code easier to read and
maintain.

B Il = oSl NS R AL
B (form) Mame | value
E'E this [BorderLayout] - Code Generation (13, 1 ==t

=[] tabbedPane [JTabbedPane]

EIE tab 1Panel [FormLayout]

labell ["text?)

Mested Class... TabiPanel

Variable Mame  tab1Panel
Variable Modi... private

L] textField1 Use Local Var... [ ] false
EI@ tab2Panel [FormLayout] GE"_'- Getter ... [] false
- label2 ("text?) Variable Ann...
L textField2 Type Parame...

Cuamborn Cemmbe [ Falom

Components having a nested class are marked with a @ overlay symbol in the Structure view.

Example source code:

public class Nestedd assDenp
ext ends JPanel
{

public Nestedd assDemo() {
i ni t Conponent s();
}

private void initConponents() {
/1 JFornDesi gner - Conponent initialization - DO NOT MODI FY //GEN-BEQ N: i ni t Conponent s
t abbedPane = new JTabbedPane();
tablPanel = new TablPanel ();
tab2Panel = new Tab2Panel ();

/1 this
set Layout (new Bor der Layout ());

[ [ ======== {ablo2n|PEanE ==—————=

t abbedPane. addTab("tab 1", tablPanel);
t abbedPane. addTab("tab 2", tab2Panel);

}

add(t abbedPane, BorderLayout.CENTER);

/1 JFornDesi gner - End of conponent initialization //CEN END:initConponents
}

/1 JFornDesi gner - Variables declaration - DO NOT MODI FY //CGEN BEG N: vari abl es
private JTabbedPane tabbedPane;

private TablPanel tablPanel;

private Tab2Panel tab2Panel ;

/'l JFornDesi gner - End of variables declaration //CGEN END:vari abl es

[/---- nested class TablPanel ---------------- -

private class TablPanel
ext ends JPanel
{

private TablPanel () {
i ni t Conponents();

private void initConponents() {
/1 JFor mDesi gner
| abel 2 = new JLabel ();
textFieldl = new JTextField();
Cel | Constraints cc = new Cel |l Constraints();
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== il § ==—————=

set Bor der ( Bor der s. TABBED DI ALOG_BORDER) ;
set Layout (new FormLayout( ... ));

[/---- label2 ----

| abel 2. set Text ("text");
add( | abel 2, cc.xy(1, 1));

[/---- textFieldl ----

add(textFieldl, cc.xy(3, 1));

/1 JFornDesi gner - End of conponent initialization //CEN END:initConmponents
}

/1 JFornDesi gner - Variables declaration - DO NOT MODI FY //GEN BEG N: vari abl es
private JLabel | abel 2;
private JTextField textFieldl;
/1 JFornDesi gner - End of variables declaration //GEN END:vari abl es
}

[/---- nested class Tab2Panel ----------------- -

private class Tab2Panel
ext ends JPanel
{

private Tab2Panel () {
ini t Conmponents();
}

private void initConponents() {
/1 JFornDesi gner - Conponent initialization - DO NOT MO FY //GEN-BEG N:i nit Conponent s
| abel 3 = new JLabel ();
checkBox1 = new JCheckBox();
Cel | Constraints cc = new Cel |l Constraints();

|| ======== thi s ========
set Bor der ( Bor der s. TABBED DI ALOG_BORDER) ;
set Layout (new FormLayout( ... ));

/== --fabell3F - -i- -
| abel 3. set Text ("text");
add(| abel 3, cc.xy(1, 1));

//---- checkBox1 ----

checkBox1. set Text ("text");

add(checkBox1, cc.xy(3, 1));

/1 JFornDesi gner - End of conponent initialization //GEN END:initConponents
}

/1 JFornDesi gner - Variables declaration - DO NOT MODI FY //GEN- BEG N: vari abl es
private JLabel |abel 3;

private JCheckBox checkBox1;

/1 JFornDesi gner - End of variables declaration //GEN END:vari abl es

When changing the nested class name in the Code Generation category, JFormDesigner also renames the
nested class in the Java source code. When removing the nested class name, then JFormDesigner does
not remove the nested class in the Java source code to avoid loss of own source code.

- 115 -



JFormDesigner 5.1 Documentation

9.2 Code Templates

When generating new Java files or classes, JFormDesigner uses the templates specified in the Preferences

dialog.

Template name

File header

Class

Empty Class

Event Handler Body

Component Initialization

Component I18n
Initialization

Component Binding
Initialization

Variables Declaration

java.awt.Dialog

java.awt.Frame

java.awt.Window

javax.swing.AbstractAction

Description

Used when creating new Java files. Contains a header comment and a package
statement.

Used when generating a new (nested) class. Contains a class declaration, a constructor,
a component initialization method and variable declarations.

Used when generating a new empty class. This can happen, if all form components are
contained in nested classes.

Used for event handler method bodies.

Replaces the variable ${component_initialization} used in other templates. Contains a
method named i ni t Conponent s. Invoke this method from your code to instantiate the
components of your form. Feel free to change the method name if you don't like it.

Used for code that initializes localized component properties if option "Generate
initComponentsI18n() method" is enabled in the Localization (Java Code Generator)
preferences or "(form)" properties.

Used for code that initializes bindings if option "Generate initComponentBindings()
method" is enabled in the Localization (Java Code Generator) preferences or "(form)"
properties.

Replaces the variable ${variables_declaration} used in other templates.

Used for classes derived from j ava. awt . Di al og. Compared to the “Class” template, this
has special constructors, which are necessary for j ava. awt . Di al og derived classes.

Used for classes derived from j ava. awt . Fr ame. Equal to the “Class” template, but
necessary because j ava. awt . Fr ane extends j ava. awt . W ndow, which has its own
template and a constructor that is not compatible with j ava. awt . Fr ane.

Used for classes derived from j ava. awt . W ndow. Compared to the “Class” template, this
has a special constructor, which are necessary for j ava. awt . W ndow derived classes.

Used for nested action classes.

You can change the existing templates or create additional templates in the Preferences dialog. It is
possible to define your own templates for specific superclasses.

Following variables can be used in the templates:

Variable name
${date}

${user}
${package_declaration}

${class_name}
${component_initialization}
${constructor_modifiers}
${extends_declaration}

${modifiers}

${variables_declaration}

Description Context
Current date. global
User name. global

package statement. If the form is not saved under one of the source folders file
specified in the Project dialog, the variable is empty (no package statement header
will be generated).

Name of the (nested) class. class
See template "Component initialization”. class
Modifiers of the constructor. Based on the class modifiers. class
The ext ends declaration of the class; empty if the class has no superclass. class

Modifiers of the (nested) class. You can specify the default modifiers in the class
Preferences dialog.

See template “Variables declaration”. class
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10 Command Line Tool

The command-line tool allows you to run some commands (e.g. Java code generation) on many forms.

Available commands

Java Code Generation: Usually its not necessary to run the Java code generator from
command-line because the Java code is automatically generated and updated while editing a form in
JFormDesigner. However in rare cases it is useful to re-generate the Java code of JFormDesigner
forms. E.g. if you want upgrade to JGoodies FormLayout 1.2, which introduced a new much shorter
syntax for encoded column and row specifications.

Externalize strings: If you have to localize many existing non-localized forms, then this command
does the job very quickly.

Convert .jfd file format: Since version 5.1, JFormDesigner supports the compact, easy-to-merge
and fast-to-load persistence format JFDML. This command allows you to convert all your .jfd files
from XML to JFDML and benefit from the new format.

Requirements

You need an installation of the JFormDesigner stand-alone edition. If you usually use one of the IDE
plug-ins, then simply download the stand-alone edition and install it.

Preferences

To specify preferences for the command-line tool, you should create a stand-alone edition project, enable
and set project specific settings and pass the project .jfdproj file to the command-line tool.

If you usually use the JFormDesigner stand-alone edition and already have a .jfdproj file, then you can
use it for the command-line tool. Otherwise start the JFormDesigner stand-alone edition and create a
new project.

If you don't use a project, then the command-line tool uses the preferences store of the stand-alone
edition. If you use one of the IDE plug-ins of JFormDesigner, you have to start the stand-alone edition
and set the necessary preferences. To transfer JFormDesigner preferences from an IDE to the
stand-alone edition, you can use the Import and Export buttons in the Preferences dialogs. Make sure
that the Code Style preferences are correct because they are not transfered from the IDE.

Command Line Syntax

Launch the command-line tool as follows, where [ ] means optional arguments and arguments in italics
must be provided by you.

java -classpath <jfd-install>/lib/JFormDesigner.jar
com.jformdesigner.application.CommandLineMain
[--generate|--i18n-externalize|--convert-jfd]
[--dry-run] [--verbose]|-v] [--recursive|-r]
[<command-specific-options>]
[ <project-path>/MyProject.jfdproj]
<folder> or <path>/MyForm1.jfd [...]

Option Description

-classpath <jfd-install>/lib/JFormDesigner.jar Specifies the JAR that contains the command-line tool. This is a
standard argument of the Java application launcher.

com.jformdesigner.application.CommandLineMain The class name of the command-line tool.
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Option
--generate

--i18n-externalize

--convert-jfd

--dry-run

--verbose or -v
--recursive or -r

--bundle-name=<bundleName>

--key-prefix=<keyPrefix>

--auto-externalize=<true|false>

--format=<JFDML|XML>

--encoding=<encoding>

--header-comment=<headerComment>

<project-path>/MyProject.jfdproj

<folder> or <path>/MyForm1.jfd [...]
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Description
Generate Java code for the given forms or folders.

Externalize strings in the given forms or folders. This requires
that you've specified Source Folders in the used project.

Convert the given .jfd files to another format.

Execute the given command, but do not save modifications. Only
shows what would happen. This option enables --verbose.

Prints file names of processed .jfd and .java files to the console.
Recursively process folders.

Only used for --i18n-externalize.

The resource bundle name used to store strings. You can use
variables {package} (package name of form) and {basename}
(basename of form). Default is "{package}.Bundle", which
creates Bundle.properties in same package as the form. This
option is ignored when processing already localized forms.

Only used for --i18n-externalize.

The prefix for generated key. You can use variable {basename}
(basename of form). Default is "{basename}". This option is
ignored when processing already localized forms.

Only used for --i18n-externalize.
Set the auto-externalize option in the processed forms. Default is
true.

Only used for --convert-jfd.
The target format into which the .jfd files will be converted.
Default is "JFDML".

Only used for --convert-jfd.

The encoding used to store JFDML content. See
java.nio.charset.Charset for supported encodings. Defaults is
"UTF-8".

Only used for --convert-jfd.

A comment that is stored in the header of the converted .jfd
files. May contain "\n", which is converted to real newline
character.

Optional JFormDesigner stand-alone edition project used to
extend the classpath and to specify other preferences. Useful
when using custom components.

List of folders or .jfd files. If a folder is specified, all .jfd files in
the folder are processed.

The options and parameters are processed in the order they are passed. An option is always used for
subsequent parameters, but not for preceding ones. E.g. "srcl --recursive src2" processes src2
recursively, but not srcl. It is also possible to specify options or projects more than once. E.g. "

projectl.jfdproj srcl project2. jfdproj

project2.jfdproj forsrc2.

src2" uses project1.jfdproj forsrcl and

Using custom components

If you're using custom components (JavaBeans) in your forms, it is necessary to tell the command-line
tool the classpath of your components, because e.g the code generator needs to load the classes of
custom components. There are two options to specify the classpath for your custom components:

JFormDesigner stand-alone edition project: The JARs and folders specified on the Classpath page in

the project settings are used by the command-line tool. This is the preferred way is you use the
stand-alone edition.
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Classpath of Java application launcher: Simply add your JARs to the -classpath option of the Java
application launcher. This is the preferred way if you use Ant (see below) or one of the IDE plug-ins
(which don't use JFormDesigner project files).

Examples

Generate code for a single form:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar
com.jformdesigner.application.CommandLineMain
--generate src/com/myproject/MyForm1.jfd

Generate code for all forms in a project that use custom components:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar;,classes,swingx.jar
com.jformdesigner.application.CommandLineMain
--generate --recursive src

Externalize strings in all forms of the src folder and use one bundle file per form and no key prefix:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar
com.jformdesigner.application.CommandLineMain
--i18n-externalize --recursive
--bundle-name={package}.{basename} --key-prefix=
MyProject.jfdproj src

Ant

Although we don't provide a special task for Ant, it is easy to invoke the JFormDesigner command-line
tool from an Ant script. The <classpath> element makes it easy to specify JARs and folders of custom
components.

<property name="command_line_html__jfd-install-dir" value="C:/Program Files/JFormDesigner"/>

<java classname="command_line_html__com.jformdesigner.application.CommandLineMain"
fork="true" failonerror="true" logError="true">
<classpath>
<pathelement location="${jfd-install-dir}/lib/JFormDesigner.jar"/>
<pathelement location="mylLibrary.jar"/>
</classpath>
<arg value="--generate"/>
<arg value="--recursive"/>
<arg value="src"/>
</java>
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11 Runtime Library

Note: If you use the Java code generator, you don't need this library.

The open-source (BSD license) runtime library allows you to load JFormDesigner XML files at runtime
within your applications. Turn off the Java code generation in the Preferences dialog or in the Project
settings if you use this library.

You'll find the library j f d-1 oader. j ar in the r edi st folder (or plug-in) of the JFormDesigner
installation; the source code is in j f d- 1 oader - src. zi p and the documentation is in
j fd-1 oader-j avadoc. zi p.

The API documentation is also available here: doc.formdev.com/jfd-loader/.

Classes

For mLoader provides methods to load JFormDesigner .jfd files into in-memory form models.

For nCr eat or creates instances of Swing components from in-memory form models and provides
methods to access components.

For nBaver saves in-memory form models to JFormDesigner .jfd files. Can be used to convert
proprietary form specifications to JFormDesigner .jfd files: first create a in-memory form model from
your form specification, then save the model to a .jfd file.

Example

The following example demonstrates the usage of FormLoader and FormCreator. It is included in the
examples distributed with all JFormDesigner editions.

public class Loader Exanpl e

{
private JDi al og dial og;

public static void main(String[] args) {
new Loader Exanpl e();
}

Loader Exanpl e() {
try {
/1 load the .jfd file into menory
For mvbdel fornmvbdel = Fornioader. | oad(
"com j f or ndesi gner/ exanpl es/ Loader Exanpl e.j fd");

/] create a dialog

For nCr eat or fornCreator = new FornCreat or (formvbdel);
fornCreator. set Target (t his);

dialog = fornCreator.createD al og(null);

/] get references to conponents
JText Fi el d nanmeFi el d = fornCreator. get Text Fi el d("naneFi el d");
JCheckBox checkBox = fornCreator. get CheckBox("checkBox");

/'l set val ues
nameFi el d. set Text ("enter nane here");
checkBox. set Sel ect ed(true);

/1 show di al og
di al og. set Mbdal (true);
di al og. pack();
di al og. show();

System out. printl n(nanmeFi el d. get Text());
System out . println(checkBox.isSel ected());
System exit(0);

} catch(Exception ex) {
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ex. printStackTrace();

}

/'l event handl er for checkBox
private void checkBoxActi onPerforned(ActionEvent e) {

JOpt i onPane. showessageDi al og(di al og, "check box clicked");
}

/1 event handl er for okButton

private void okButtonActionPerforned() {
di al og. di spose();

}
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12 JavaBeans

What is a Java Bean?
A Java Bean is a reusable software component that can be manipulated visually in a builder tool.

JavaBean (components) are self-contained, reusable software units that can be visually composed into
composite components and applications. A bean is a Java class that:

is public and not abstract
has a public "null" constructor (without parameters)

has properties defined by public getter and setter methods.
JFormDesigner supports:

Visual beans (must inherit from j ava. awt . Conponent ).

Non-visual beans.

BeanInfo

JFormDesigner supports/uses following classes/interfaces specified in the j ava. beans package:

BeanInfo

BeanDescriptor

EventSetDescriptor

PropertyDescriptor

PropertyEditor (incl. support for custom and paintable editors)
Customizer

If you are writing BeanInfo classes for your custom components, you can specify additional information
needed by JFormDesigner using the j ava. beans. Feat ur eDescri pt or extension mechanism.

You can also use BeanInfo Annotations to specify these attributes without the pain of implementing
BeanInfo classes.

For examples using BeanInfo Annotations, example implementations of BeanInfo classes and
PropertyEditors, take a look at the examples.

BeanDescriptor Attributes

Following attributes are supported in BeanDescriptor:

Attribute Name Description

isContainer Specifies whether a component is a container or not. A container can have child components.
The value must be a Bool ean. Default is false. E.g.

beanDesc. set Val ue("i sCont ai ner", Bool ean. TRUE);

containerDelegate If components should be added to a descendant of a container, then it is possible to specify a
method that returns the container for the children. JFr ane. get Cont ent Pane() is a example
for such a method. The value must be a Stri ng and specifies the name of a method that takes
no arguments and returns a j ava. awt . Cont ai ner. E.g.

beanDesc. set Val ue( " cont ai ner Del egat e", "get Content Pane");

layoutManager Allows the specification of a layout manager, which is used when adding the component to a
form. If specified, then JFormDesigner does not allow the selection of a layout manager. The
value must be a d ass. E.g.
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Attribute Name Description

beanDesc. set Val ue("| ayout Manager", Border Layout. cl ass);

persistenceDelegate Specifies an instance of a class, which extends j ava. beans. Per si st enceDel egat e, that can
be used to persist an instance of the bean. E.g.

beanDesc. set Val ue( " per si st enceDel egat e",

new MyBeanPer si st enceDel egate());

PropertyDescriptor Attributes

Following attributes are supported in PropertyDescriptor:

Attribute Name

category

enumerationValues

extraPersistenceDelegates

imports

notMultiSelection

notNull

Description

Specifies the property category to which the property belongs. JFormDesigner adds the
specified category to the Properties view. The value must be a Stri ng.

propDesc. set Val ue("category", "My Properties");

Specifies a list of valid property values. The value must be a Obj ect[] . For each
property value, the Obj ect [] must contain three items:

Name: A displayable name for the property value.
Value: The actual property value.

Java Initialization String: A Java code piece used when generating code.

propDesc. set Val ue( " enuner ati onVal ues”, new Cbject[] {
"horizontal ", JS|ider.HORI ZONTAL, "JSlider. HORI ZONTAL",
"vertical", JSl i der. VERTI CAL, "JSlider. VERTI CAL" });

Specifies a list of persistence delegates for classes. The value must be a Obj ect[]. For
each class, the Obj ect[] must contain two items:

Class: The class for which the persistence delegate should be used.

Persistence delegate: Instance of a class, which extends
j ava. beans. Per si st enceDel egat e, that should be used to persist an instance of
the specified class.

Use the attribute "persistenceDelegate" (see below) to specify a persistence delegate for
the property value. Use this attribute to specify persistence delegates for classes that
are referenced by the property value. E.g. if a property value references classes
MyClass1 and MyClass2:

propDesc. set Val ue( " extraPersi st enceDel egat es”, new Object[] {
M/Cl assl. cl ass, new MyCl asslPersi st enceDel egate(),
M/Cl ass2. cl ass, new MyCl ass2Per si st enceDel egat e(),

s

Specifies one or more class hames for which import statements should be generated by
the Java code generator. This is useful if you don't use full qualified class names in
enumner at i onVal ues or PropertyEditor. get Javal nitializationString(). The value
must bea Stringor String[]. E.g.

propDesc. set Val ue("i nports", "com nyconpany. MyConst ants");
propDesc. set Val ue("i nports", new String[] {

"com nyconpany. MyConst ant s",

"com nyconpany. MyExt endedConst ants" });

Specifies whether the property is not shown in the Properties view when multiple
components are selected. The value must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("not Mul ti Sel ecti on", Bool ean. TRUE);

Specifies that a property can not set to nul | in the Properties view. If true, the Set
Value to null command is disabled. The value must be a Bool ean. Default is false. E.g.
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Attribute Name Description
propDesc. set Val ue("not Nul I *, Bool ean. TRUE) ;
notRestoreDefault Specifies that a property value can not restored to the default in the Properties view. If

true, the Restore Default Value command is disabled. The value must be a Bool ean.
Default is false. E.g.

propDesc. set Val ue( " not Rest oreDefaul t", Bool ean. TRUE) ;

persistenceDelegate Specifies an instance of a class, which extends j ava. beans. Per si st enceDel egat e, that
can be used to persist an instance of a property value. E.g.

propDesc. set Val ue( " per si st enceDel egat e",
new MyPropPer si st enceDel egate());

readOnly Specifies that a property is read-only in the Properties view. The value must be a
Bool ean. Default is false. E.g.

propDesc. set Val ue("readOnl y", Bool ean. TRUE) ;

transient Specifies that the property value should not persisted and no code should generated.
The value must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("transi ent", Bool ean. TRUE);

variableDefault Specifies whether the default property value depends on other property values. The
value must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("vari abl eDefaul t", Bool ean. TRUE) ;

Design time

JavaBeans support the concept of "design"-mode, when JavaBeans are used in a GUI design tool, and
"run"-mode, when JavaBeans are used in an application.

You can use the method j ava. beans. Beans. i sDesi gnTi me() in your JavaBean to determine whether it
is running in JFormDesigner or in your application.

Reload beans

JFormDesigner automatically reloads classes of custom JavaBeans when changed. So you can change the
source code of used custom JavaBeans, compile them in your IDE and use them in JFormDesigner
immediately without restarting.

You can also manually reload classes:

Stand-alone: Select View > Refresh Designer from the menu or press F5.

IDE plug-ins: Click the Refresh Designer button (Q'&@) in the designer tool bar.
Refresh does following:

1. Create a new class loader for loading JavaBeans, BeanInfos and Icons.
2. Recreates the form in the active Design view.

Unsupported standard components

all AWT components
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13 Annotations

The @eanl nf o and @r oper t yDesc annotations make it very easy to specifying BeanInfo information
directly in the custom component. Its no longer necessary to implement extra BeanInfo classes. This
drastically reduces time and code needed to create BeanInfo information.

When using the JFormDesigner annotations, you have to add the library j f d- annot ati ons. j ar (from
redi st folder) to the build path of your project (necessary for the Java compiler). The documentation
isin j fd-annot ati ons-j avadoc. zi p. It is not necessary to distribute j f d- annot ati ons. j ar with
your application.

The API documentation is also available here: doc.formdev.com/jfd-annotations/

@BeanInfo

This annotation can be used to specify additional information for constructing a BeanInfo class and its
BeanDescriptor.

Example for specifying a description, an icon, property display names and flags, and property categories:

@eanl nf o(
description="M/ Bean",
i con="M/Bean. gi f",
properties={
@r opert yDesc(nane="nagni t ude", di splayNane="nagnitude (in %", preferred=true)
@r opertyDesc(name="enabl ed", expert=true)

e
cat egori es={
@rat egor y(nane="Si zes", properties={"preferredSize", "mninunSize", "maxi munSi ze"}),
@cat egor y(nane="Col ors", properties={"background", "foreground"}),
}
)
public class MyBean extends JConpoment { ... }

Example for a container component that has a content pane:

@eanl nf o(i sCont ai ner=true, contai nerDel egat e="get Cont ent Pane")
public class MyPanel extends JPanel { ... }

@PropertyDesc

This annotation can be used to specify additional information for constructing a PropertyDescriptor.

This annotation may be used in a @eanl nf o annotation (see @eanl nf 0. properti es()) or may be
attached to property getter or setter methods. If the getter method of a property is annotated, then the
setter method of the same property is not checked for this annotation.

Important: This annotation requires that the @eanl nf o annotation is specified for the bean class.
Otherwise this annotation is ignored when specified at methods.

Example for attaching this annotation to a property getter method:

@ropert yDesc(di spl ayName="rmagni tude (in %", preferred=true)
public int getMgnitude() {

return nmagnitude
}
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Example for specifying this annotation in a @eanl nf o annotation:

@eanl nf o(
properties={
@r opert yDesc(nane="nagni t ude", displayNane="nagnitude (in %", preferred=true)
}

)
public class MyBean extends JConpoment { ... }

@DesignCreate

This annotation can be used to mark a static method that should be invoked by JFormDesigner to create
instances of the bean, which are then used in the JFormDesigner Design view. The annotated method
must be static, must not have parameters and must return the instance of created bean.

Example for using this annotation to initialize the bean with test data for the Design view:

public class MyBean extends JConponent {
@esi gnCreat e
private static MyBean designCreate() {
MyBean nyBean = new MyBean();
nmyBean. set Dat a( new SomeDunmyDat aFor Desi gni ng() );
return mnyBean;

}

public MyBean() {
...

}
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14 JGoodies Forms & Looks

JFormDesigner supports and uses software provided by JGoodies Karsten Lentzsch.

The JGoodies Forms framework support is very extensive. Not only the layout manager FormLayout is
supported, also some important helper classes are supported: Bor der s, Conponent Fact ory and
For nfFact ory (com.jgoodies.forms.factories).

JGoodies Looks look and feels are built-in so that you can preview your forms using those popular look
and feels. JGoodies Looks examples contains some useful components to build Eclipse like panels:
JGoodies UIF lite.

JGoodies Forms ComponentFactory

The JGoodies Forms ComponentFactory (com.jgoodies.forms.factories) defines three factory methods,
which create components. You find these components in the palette category JGoodies.

Label : A label with an optional mnemonic. The mnemonic and mnemonic index are defined by a
single ampersand (&). For example "&Save" or "Save &As". To use the ampersand itself duplicate it,
for example "Look&&Feel".

Titl e: A label that uses the foreground color and font of a Ti t| edBor der with an optional
mnemonic. The mnemonic and mnemonic index are defined by a single ampersand (&).

Titl ed Separator: A labeled separator. Useful to separate paragraphs in a panel, which is often a
better choice than a Ti t | edBor der .

text

JGoodies UIF lite

JFormDesigner supports Si nmpl el nt er nal Franme and Ul FSpl i t Pane from the JGoodies UIF lite package,
which is part of the JGoodies Looks examples. You find both components in the palette category
JGoodies.

Si npl el nt er nal Frane is an Eclipse like frame. Ul FSpl i t Pane is a

Structure Properties
TTree subclass of JSpl i t Pane that hides the divider border. Use
- colors Color: Ul FSpli t Pane if you want to put two Si npl el nt er nal Franes into a
- |, sports | | R@B: split pane. See example exanpl es/ Ul FLi t ePanel . j f d.
41, food

When using one of these components, you have to add the library redi st/j goodi es-uif-lite.jar
to the classpath of your application. Or add the source code to your repository and compile it into
your application. The source code is in redi st/ goodi es-uif-lite-src.zip.

The API documentation is also available here: doc.formdev.com/jgoodies-uif-lite/.
IDE plug-ins: If you use one of the UIF lite components the first time, the JFormDesigner IDE

plug-in ask you whether it should copy the required library (and its source code and documentation)
to the IDE project and add it to the classpath of the IDE project.

To add a toolbar to a Si npl el nt er nal Frane, add a JTool Bar to the Design view, select the
Si npl el nt er nal Fr ame, select the "toolBar" property in the Properties view and assign the toolbar to it.

Folders e | Folders T
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15 Examples & Redistributables

A JFormDesigner installation includes example source code and redistributable files. Because
JFormDesigner is available in several editions and each IDE plug-in has its own requirements regarding
plug-in directory structure and installation location, the installation location of the examples and
redistributables depends on the JFormDesigner edition. The tables below list the locations for each
JFormDesigner edition.

Examples

The exanpl es folder (or exanpl es. zi p archive) contains example source code and forms. See
exanpl es/ READVE. ht m for details.

Edition Location

Stand-alone <j f or ndesi gner - i nst al | >/ exanpl es/

Mac OS X: <JFor nDesi gner . app>/ exanpl es/ (right-click on JFormDesigner application and
select "Show Package Contents" from the context menu to see contents of
<JFormDesigner.app>)

Eclipse plug-in <eclipse-instal |l >/features/comjforndesigner_x.x.x/exanpl es. zi p or
<ecl i pse-install>/dropi ns/ JFor nDesi gner - x. x- ecl i pse/ f eat ur es/
com j f or ndesi gner _x. x. x/ exanpl es. zi p

NetBeans plug-in <net beans-instal | >/jforndesi gner/exanpl es. zi p

Mac OS X:

<Net Beans. app>/ Cont ent s/ Resour ces/ Net Beans/ j f or ndesi gner/ exanpl es. zi p
(right-click on NetBeans application and select "Show Package Contents" from the context
menu to see contents of <NetBeans.app>)

IntelliJ IDEA plug-in <user-home>/. I ntelliJl deaXX/ confi g/ pl ugi ns/ JFor nDesi gner/ exanpl es. zi p or
<intellij-idea-install>/plugins/JFornDesi gner/exanpl es. zi p

Mac OS X: <user - home>/ Li brary/ Appl i cati on
Support/IntelliJldeaXX/ JFor nDesi gner/exanpl es. zi p

JBuilder plug-in <j bui I der-install>/1ib/ext/JFornDesi gner/exanpl es. zi p

Redistributables

The r edi st folder contains the JFormDesigner Annotations Library, the JFormDesigner Runtime Library
and 3rd party open source files (layout manager, beans binding, etc). See r edi st/ README. ht il for
information about licenses.

Edition Location

Stand-alone <j formdesi gner-install>/redist/

Mac OS X: <JFor nDesi gner . app>/redi st/ (right-click on JFormDesigner application and
select "Show Package Contents" from the context menu to see contents of
<JFormDesigner.app>)

Eclipse plug-in <ecl i pse-install>/plugins/comjforndesigner.redist_x.x.x/ or
<ecl i pse-instal |l >/dropi ns/ JFor nDesi gner - x. x- ecl i pse/ pl ugi ns/
com j for ndesi gner. redi st _x. x. x/

NetBeans plug-in <net beans-instal | >/jforndesi gner/redist/
Mac OS X: <Net Beans. app>/ Cont ent s/ Resour ces/ Net Beans/ j f or ndesi gner/r edi st/

(right-click on NetBeans application and select "Show Package Contents" from the context
menu to see contents of <NetBeans.app>)

-128 -



Edition

IntelliJ IDEA plug-in

JBuilder plug-in
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Location

<user-home>/. I ntelliJl deaXX/ confi g/ pl ugi ns/ JFor nDesi gner/redi st/ or
<intellij-idea-install>/plugins/JFormDesigner/redist/

Mac OS X: <user - honme>/ Li brary/ Appl i cati on
Support/IntelliJldeaXX/ JFornDesi gner/redist/

<j buil der-install>/1ib/ext/JFornDesi gner/redist/
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